Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**

indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**

indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**

indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**

indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Preface

## Technical support

<table>
<thead>
<tr>
<th>Country</th>
<th>Hotline</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>+86 400 810 4288</td>
</tr>
<tr>
<td>Germany</td>
<td>+49 911 895 7222</td>
</tr>
<tr>
<td>Italy</td>
<td>+39 (02) 24362000</td>
</tr>
<tr>
<td>India</td>
<td>+91 22 2760 0150</td>
</tr>
<tr>
<td>Turkey</td>
<td>+90 (216) 4440747</td>
</tr>
</tbody>
</table>

Further service contact information:
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preface</strong></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>Fundamental safety instructions</td>
<td>9</td>
</tr>
<tr>
<td>1.1</td>
<td>General safety instructions</td>
<td>9</td>
</tr>
<tr>
<td>1.2</td>
<td>Industrial security</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>SINAMICS V-ASSISTANT</td>
<td>11</td>
</tr>
<tr>
<td>2.1</td>
<td>Device combination</td>
<td>12</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Device combination of SINAMICS V90 PN and SIMOTICS S-1FL6</td>
<td>12</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Device combination of SINAMICS V90 PTI and SIMOTICS S-1FL6</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>User interface</td>
<td>19</td>
</tr>
<tr>
<td>3.1</td>
<td>Working modes</td>
<td>19</td>
</tr>
<tr>
<td>3.2</td>
<td>User interface - overview</td>
<td>24</td>
</tr>
<tr>
<td>3.3</td>
<td>Menu bar</td>
<td>26</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Menu bar - overview</td>
<td>26</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Project menu</td>
<td>26</td>
</tr>
<tr>
<td>3.3.2.1</td>
<td>Project -&gt; New project</td>
<td>26</td>
</tr>
<tr>
<td>3.3.2.2</td>
<td>Project -&gt; Open project</td>
<td>27</td>
</tr>
<tr>
<td>3.3.2.3</td>
<td>Project -&gt; Save project</td>
<td>28</td>
</tr>
<tr>
<td>3.3.2.4</td>
<td>Project -&gt; Save project as</td>
<td>29</td>
</tr>
<tr>
<td>3.3.2.5</td>
<td>Project -&gt; Print</td>
<td>29</td>
</tr>
<tr>
<td>3.3.2.6</td>
<td>Project -&gt; Language</td>
<td>30</td>
</tr>
<tr>
<td>3.3.2.7</td>
<td>Project -&gt; Exit</td>
<td>30</td>
</tr>
<tr>
<td>3.3.3</td>
<td>Edit menu</td>
<td>30</td>
</tr>
<tr>
<td>3.3.3.1</td>
<td>Edit -&gt; Cut</td>
<td>30</td>
</tr>
<tr>
<td>3.3.3.2</td>
<td>Edit -&gt; Copy</td>
<td>31</td>
</tr>
<tr>
<td>3.3.3.3</td>
<td>Edit -&gt; Paste</td>
<td>31</td>
</tr>
<tr>
<td>3.3.4</td>
<td>Switch menu</td>
<td>31</td>
</tr>
<tr>
<td>3.3.4.1</td>
<td>Switch -&gt; Go offline</td>
<td>31</td>
</tr>
<tr>
<td>3.3.4.2</td>
<td>Switch -&gt; Go online</td>
<td>31</td>
</tr>
<tr>
<td>3.3.5</td>
<td>Tools menu</td>
<td>32</td>
</tr>
<tr>
<td>3.3.5.1</td>
<td>Tools -&gt; Save parameters to ROM</td>
<td>32</td>
</tr>
<tr>
<td>3.3.5.2</td>
<td>Tools -&gt; Restart drive</td>
<td>32</td>
</tr>
<tr>
<td>3.3.5.3</td>
<td>Tools -&gt; Reset absolute encoder</td>
<td>33</td>
</tr>
<tr>
<td>3.3.5.4</td>
<td>Tools -&gt; Factory default</td>
<td>33</td>
</tr>
<tr>
<td>3.3.5.5</td>
<td>Tools -&gt; Upload parameters</td>
<td>35</td>
</tr>
<tr>
<td>3.3.6</td>
<td>Help menu</td>
<td>35</td>
</tr>
<tr>
<td>3.3.6.1</td>
<td>Help -&gt; View help</td>
<td>35</td>
</tr>
<tr>
<td>3.3.6.2</td>
<td>Help -&gt; About SINAMICS V-ASSISTANT</td>
<td>36</td>
</tr>
<tr>
<td>3.4</td>
<td>Toolbar</td>
<td>36</td>
</tr>
<tr>
<td>3.5</td>
<td>Alarm window</td>
<td>37</td>
</tr>
<tr>
<td>3.6</td>
<td>Function keys and shortcuts</td>
<td>38</td>
</tr>
</tbody>
</table>
### Table of Contents

#### 4 Task navigation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Selecting drive</td>
<td>41</td>
</tr>
<tr>
<td>4.1.1 Selecting drive</td>
<td>42</td>
</tr>
<tr>
<td>4.1.2 Selecting motor</td>
<td>44</td>
</tr>
<tr>
<td>4.1.3 Control mode</td>
<td>45</td>
</tr>
<tr>
<td>4.1.4 Jog</td>
<td>47</td>
</tr>
<tr>
<td>4.2 Setting PROFINET (V90 PN only)</td>
<td>48</td>
</tr>
<tr>
<td>4.2.1 Selecting telegram</td>
<td>48</td>
</tr>
<tr>
<td>4.2.2 Configuring network</td>
<td>51</td>
</tr>
<tr>
<td>4.3 Parameterizing</td>
<td>52</td>
</tr>
<tr>
<td>4.3.1 Setting electronic gear ratio (V90 PTI only)</td>
<td>53</td>
</tr>
<tr>
<td>4.3.1.1 Overview</td>
<td>53</td>
</tr>
<tr>
<td>4.3.1.2 Mechanical structure</td>
<td>54</td>
</tr>
<tr>
<td>4.3.2 Setting mechanism</td>
<td>56</td>
</tr>
<tr>
<td>4.3.3 Setting parameter setpoint</td>
<td>56</td>
</tr>
<tr>
<td>4.3.3.1 Position setpoint</td>
<td>57</td>
</tr>
<tr>
<td>4.3.3.2 Speed setpoint</td>
<td>66</td>
</tr>
<tr>
<td>4.3.3.3 Torque setpoint</td>
<td>68</td>
</tr>
<tr>
<td>4.3.4 Configuring ramp function (V90 PN only)</td>
<td>69</td>
</tr>
<tr>
<td>4.3.5 Setting limits</td>
<td>71</td>
</tr>
<tr>
<td>4.3.5.1 Torque limit</td>
<td>71</td>
</tr>
<tr>
<td>4.3.5.2 Speed limit</td>
<td>73</td>
</tr>
<tr>
<td>4.3.6 Configuring inputs/outputs</td>
<td>75</td>
</tr>
<tr>
<td>4.3.6.1 Assigning digital inputs</td>
<td>75</td>
</tr>
<tr>
<td>4.3.6.2 Assigning digital outputs</td>
<td>76</td>
</tr>
<tr>
<td>4.3.6.3 Assigning analog outputs (V90 PTI only)</td>
<td>77</td>
</tr>
<tr>
<td>4.3.7 Configuring referencing</td>
<td>78</td>
</tr>
<tr>
<td>4.3.7.1 Setting referencing</td>
<td>78</td>
</tr>
<tr>
<td>4.3.7.2 Setting software position limit</td>
<td>84</td>
</tr>
<tr>
<td>4.3.8 Setting encoder pulse output (V90 PTI only)</td>
<td>85</td>
</tr>
<tr>
<td>4.3.9 Backlash compensation</td>
<td>85</td>
</tr>
<tr>
<td>4.3.10 Viewing all parameters</td>
<td>87</td>
</tr>
<tr>
<td>4.4 Commissioning</td>
<td>90</td>
</tr>
<tr>
<td>4.4.1 Testing interface</td>
<td>90</td>
</tr>
<tr>
<td>4.4.1.1 I/O simulation</td>
<td>90</td>
</tr>
<tr>
<td>4.4.1.2 Digital inputs/outputs (DI/DOs)</td>
<td>94</td>
</tr>
<tr>
<td>4.4.1.3 Analog inputs (AI)</td>
<td>105</td>
</tr>
<tr>
<td>4.4.1.4 Analog outputs (AO)</td>
<td>106</td>
</tr>
<tr>
<td>4.4.1.5 Pulse train inputs (PTIs)</td>
<td>107</td>
</tr>
<tr>
<td>4.4.1.6 Pulse train encoder outputs (PTOs)</td>
<td>107</td>
</tr>
<tr>
<td>4.4.2 Testing motor</td>
<td>107</td>
</tr>
<tr>
<td>4.4.2.1 Jog</td>
<td>107</td>
</tr>
<tr>
<td>4.4.2.2 Position trial run (V90 PTI only)</td>
<td>108</td>
</tr>
<tr>
<td>4.4.3 Optimizing drive</td>
<td>109</td>
</tr>
<tr>
<td>4.4.3.1 One-button auto tuning</td>
<td>110</td>
</tr>
<tr>
<td>4.4.3.2 Real-time auto tuning</td>
<td>114</td>
</tr>
<tr>
<td>4.4.3.3 Manual tuning</td>
<td>117</td>
</tr>
<tr>
<td>4.4.3.4 Low frequency vibration suppression</td>
<td>120</td>
</tr>
<tr>
<td>4.5 Diagnostics</td>
<td>122</td>
</tr>
<tr>
<td>4.5.1 Monitoring status</td>
<td>122</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>4.5.2</td>
<td>Tracing signals</td>
</tr>
<tr>
<td>4.5.2.1</td>
<td>Trace configuration</td>
</tr>
<tr>
<td>4.5.3</td>
<td>Measuring machine</td>
</tr>
<tr>
<td>4.6</td>
<td>Communicating with the PLC (V90 PTI only)</td>
</tr>
<tr>
<td>4.6.1</td>
<td>USS communication</td>
</tr>
<tr>
<td>4.6.2</td>
<td>Modbus communication</td>
</tr>
<tr>
<td>4.6.2.1</td>
<td>Cyclic communication</td>
</tr>
<tr>
<td>4.6.2.2</td>
<td>Acyclic communication</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
</tbody>
</table>
### 1.1 General safety instructions

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>danger to life if the safety instructions and residual risks are not observed</strong></td>
</tr>
<tr>
<td>If the safety instructions and residual risks in the associated hardware documentation are not observed, accidents involving severe injuries or death can occur.</td>
</tr>
<tr>
<td>• Observe the safety instructions given in the hardware documentation.</td>
</tr>
<tr>
<td>• Consider the residual risks for the risk evaluation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>danger to life or malfunctions of the machine as a result of incorrect or changed parameterization</strong></td>
</tr>
<tr>
<td>As a result of incorrect or changed parameterization, machines can malfunction, which in turn can lead to injuries or death.</td>
</tr>
<tr>
<td>• Protect the parameterization (parameter assignments) against unauthorized access.</td>
</tr>
<tr>
<td>• Respond to possible malfunctions by applying suitable measures (e.g. emergency stop or emergency off).</td>
</tr>
</tbody>
</table>
1.2 Industrial security

Note

Industrial security

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens products and solutions only represent one component of such a concept.

The customer is responsible for preventing unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more information about industrial security, please visit:


Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed at:


<table>
<thead>
<tr>
<th>![WARNING]</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Danger to life as a result of unsafe operating states resulting from software manipulation</strong></td>
</tr>
<tr>
<td>Software manipulations (e.g. viruses, trojans, malware or worms) can cause unsafe operating states in your system that may lead to death, serious injury, and property damage.</td>
</tr>
<tr>
<td>• Keep the software up to date.</td>
</tr>
<tr>
<td>• Incorporate the automation and drive components into a holistic, state-of-the-art industrial security concept for the installation or machine.</td>
</tr>
<tr>
<td>• Make sure that you include all installed products into the holistic industrial security concept.</td>
</tr>
<tr>
<td>• Protect files stored on exchangeable storage media from malicious software by with suitable protection measures, e.g. virus scanners.</td>
</tr>
</tbody>
</table>
The SINAMICS V-ASSISTANT engineering tool is designed for faster commissioning and diagnostics for the following SINAMICS V90 drive variants:

- SINAMICS V90 drives with the PROFINET interface (referred to as SINAMICS V90 PN)
- SINAMICS V90 drives with the pulse train, USS/Modbus interface (referred to as SINAMICS V90 PTI)

The software runs on a personal computer with Windows operating systems and utilizes graphical user interface to interact with users and communicates with SINAMICS V90 via a USB cable. It can be used to modify parameters and monitor status of SINAMICS V90 drives.

**Note**

To ensure the stability of online commissioning, Siemens recommends that you use a shielded USB cable of no longer than 3 m with ferrite cores on both ends.

**Note**

The minimum screen resolution must be $1024 \times 768$. 
2.1 Device combination

2.1.1 Device combination of SINAMICS V90 PN and SIMOTICS S-1FL6

V90 PN 200 V servo system

<table>
<thead>
<tr>
<th>SIMOTICS S-1FL6 low inertia servo motors</th>
<th>SINAMICS V90 PN 200 V servo drives</th>
<th>MOTION-CONNECT 300 pre-assembled cables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated torque (Nm)</td>
<td>Rated power (kW)</td>
<td>Rated speed (rpm)</td>
</tr>
<tr>
<td>0.16</td>
<td>0.05</td>
<td>3000</td>
</tr>
<tr>
<td>0.32</td>
<td>0.1</td>
<td>3000</td>
</tr>
<tr>
<td>0.64</td>
<td>0.2</td>
<td>3000</td>
</tr>
<tr>
<td>1.27</td>
<td>0.4</td>
<td>3000</td>
</tr>
<tr>
<td>2.39</td>
<td>0.75</td>
<td>3000</td>
</tr>
<tr>
<td>3.18</td>
<td>1</td>
<td>3000</td>
</tr>
<tr>
<td>4.78</td>
<td>1.5</td>
<td>3000</td>
</tr>
<tr>
<td>6.37</td>
<td>2</td>
<td>3000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Incremental encoder TTL 2500 ppr | A | Incremental encoder TTL 2500 ppr | C | T
Absolute encoder single-turn 21-bit | M | Absolute encoder single-turn 21-bit | D | B
## V90 PN 400 V servo system

<table>
<thead>
<tr>
<th>SIMOTICS S-1FL6 high inertia servo motors with straight connectors</th>
<th>SINAMICS V90 PN 400 V servo drives</th>
<th>MOTION-CONNECT 300 pre-assembled cables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rated torque (Nm)</strong></td>
<td><strong>Rated power (kW)</strong></td>
<td><strong>Rated speed (rpm)</strong></td>
</tr>
<tr>
<td><strong>1FL60</strong></td>
<td><strong>6SL3210-5</strong></td>
<td><strong>6FX3002-5</strong></td>
</tr>
<tr>
<td>1.27</td>
<td>0.4</td>
<td>3000</td>
</tr>
<tr>
<td>2.39</td>
<td>0.75</td>
<td>3000</td>
</tr>
<tr>
<td>3.58</td>
<td>0.75</td>
<td>2000</td>
</tr>
<tr>
<td>4.78</td>
<td>1.0</td>
<td>2000</td>
</tr>
<tr>
<td>7.16</td>
<td>1.5</td>
<td>2000</td>
</tr>
<tr>
<td>8.36</td>
<td>1.75</td>
<td>2000</td>
</tr>
<tr>
<td>9.55</td>
<td>2.0</td>
<td>2000</td>
</tr>
<tr>
<td>11.9</td>
<td>2.5</td>
<td>2000</td>
</tr>
<tr>
<td>16.7</td>
<td>3.5</td>
<td>2000</td>
</tr>
<tr>
<td>23.9</td>
<td>5.0</td>
<td>2000</td>
</tr>
<tr>
<td>33.4</td>
<td>7.0</td>
<td>2000</td>
</tr>
</tbody>
</table>

- **Incremental encoder TTL 2500 ppr**
- **Absolute encoder 20-bit + 12-bit multi-turn**
### SIMOTICS S-1FL6 high inertia servo motors with angular connectors

<table>
<thead>
<tr>
<th>Rated torque (Nm)</th>
<th>Rated power (kW)</th>
<th>Rated speed (rpm)</th>
<th>Shaft height (mm)</th>
<th>Article number 1FL60</th>
<th>Article number 6SL3210-5</th>
<th>Frame size</th>
<th>Article number 6FX3002-5</th>
<th>Article number 6FX3002-5</th>
<th>Article number 6FX3002-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.27</td>
<td>0.4</td>
<td>3000</td>
<td>45</td>
<td>42-1AF61-2</td>
<td>FE10-4UF0</td>
<td>FSAA</td>
<td>CL02-1AD0</td>
<td>BL03-1AD0</td>
<td>-1AD0 (3 m)</td>
</tr>
<tr>
<td>2.39</td>
<td>0.75</td>
<td>3000</td>
<td></td>
<td>44-1AF61-2</td>
<td>FE10-8UF0</td>
<td>FSA</td>
<td>CL02-1AF0</td>
<td>BL03-1AF0</td>
<td>-1AF0 (5 m)</td>
</tr>
<tr>
<td>3.58</td>
<td>0.75</td>
<td>2000</td>
<td>65</td>
<td>61-1AC61-2</td>
<td>FE11-0UF0</td>
<td>CL02-1AH0</td>
<td>BL03-1BA0</td>
<td>BL03-1BF0</td>
<td>-1AH0 (7 m)</td>
</tr>
<tr>
<td>4.78</td>
<td>1.0</td>
<td>2000</td>
<td></td>
<td>62-1AC61-2</td>
<td></td>
<td>CL02-1BA0</td>
<td>BL03-1CA0</td>
<td></td>
<td>-1BA0 (10 m)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CL02-1BF0</td>
<td></td>
<td>-1BF0 (15 m)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CL02-1CA0</td>
<td></td>
<td>-1CA0 (20 m)</td>
</tr>
<tr>
<td>7.16</td>
<td>1.5</td>
<td>2000</td>
<td></td>
<td>64-1AC61-2</td>
<td>FE11-5UF0</td>
<td>FSB</td>
<td>CL12-1AD0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.36</td>
<td>1.75</td>
<td>2000</td>
<td></td>
<td>66-1AC61-2</td>
<td>FE12-0UF0</td>
<td>CL12-1AF0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.55</td>
<td>2.0</td>
<td>2000</td>
<td></td>
<td>67-1AC61-2</td>
<td></td>
<td>CL12-1AH0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.9</td>
<td>2.5</td>
<td>2000</td>
<td>90</td>
<td>90-1AC61-2</td>
<td>FE13-5UF0</td>
<td>FSC</td>
<td>CL12-1BF0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16.7</td>
<td>3.5</td>
<td>2000</td>
<td></td>
<td>92-1AC61-2</td>
<td>FE15-0UF0</td>
<td>CL12-1CA0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23.9</td>
<td>5.0</td>
<td>2000</td>
<td></td>
<td>94-1AC61-2</td>
<td></td>
<td>CL12-1BF0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33.4</td>
<td>7.0</td>
<td>2000</td>
<td></td>
<td>96-1AC61-2</td>
<td>FE17-0UF0</td>
<td>FSC</td>
<td>CL12-1CA0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

You can select a SINAMICS V90 PN servo drive for all the SIMOTICS S-1FL6 servo motors whose rated power values are equal to or smaller than that specified as matching with this servo drive in the table above.
## 2.1.2 Device combination of SINAMICS V90 PTI and SIMOTICS S-1FL6

### V90 200 V servo system

<table>
<thead>
<tr>
<th>SIMOTICS S-1FL6 low inertia servo motors</th>
<th>SINAMICS V90 200 V servo drives</th>
<th>MOTION-CONNECT 300 pre-assembled cables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated torque (Nm)</td>
<td>Rated power (kW)</td>
<td>Rated speed (rpm)</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>0.16</td>
<td>0.05</td>
<td>3000</td>
</tr>
<tr>
<td>0.32</td>
<td>0.1</td>
<td>3000</td>
</tr>
<tr>
<td>0.64</td>
<td>0.2</td>
<td>3000</td>
</tr>
<tr>
<td>1.27</td>
<td>0.4</td>
<td>3000</td>
</tr>
<tr>
<td>2.39</td>
<td>0.75</td>
<td>3000</td>
</tr>
<tr>
<td>3.18</td>
<td>1</td>
<td>3000</td>
</tr>
<tr>
<td>4.78</td>
<td>1.5</td>
<td>3000</td>
</tr>
<tr>
<td>6.37</td>
<td>2</td>
<td>3000</td>
</tr>
</tbody>
</table>

- Incremental encoder TTL 2500 ppr
- Absolute encoder single-turn 21-bit
## V90 400 V servo system

<table>
<thead>
<tr>
<th>SIMOTICS S-1FL6 high inertia servo motors with straight connectors</th>
<th>SINAMICS V90 400 V servo drives</th>
<th>MOTION-CONNECT 300 pre-assembled cables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated torque (Nm)</td>
<td>Rated power (kW)</td>
<td>Rated speed (rpm)</td>
</tr>
<tr>
<td>1.27</td>
<td>0.4</td>
<td>3000</td>
</tr>
<tr>
<td>2.39</td>
<td>0.75</td>
<td>3000</td>
</tr>
<tr>
<td>3.58</td>
<td>0.75</td>
<td>2000</td>
</tr>
<tr>
<td>4.78</td>
<td>1.0</td>
<td>2000</td>
</tr>
<tr>
<td>7.16</td>
<td>1.5</td>
<td>2000</td>
</tr>
<tr>
<td>8.36</td>
<td>1.75</td>
<td>2000</td>
</tr>
<tr>
<td>9.55</td>
<td>2.0</td>
<td>2000</td>
</tr>
<tr>
<td>11.9</td>
<td>2.5</td>
<td>2000</td>
</tr>
<tr>
<td>16.7</td>
<td>3.5</td>
<td>2000</td>
</tr>
<tr>
<td>23.9</td>
<td>5.0</td>
<td>2000</td>
</tr>
<tr>
<td>33.4</td>
<td>7.0</td>
<td>2000</td>
</tr>
</tbody>
</table>

Incremental encoder TTL 2500 ppr
Absolute encoder 20-bit + 12-bit multi-turn
### SIMOTICS S-1FL6 high inertia servo motors with angular connectors

<table>
<thead>
<tr>
<th>Rated torque (Nm)</th>
<th>Rated power (kW)</th>
<th>Rated speed (rpm)</th>
<th>Shaft height (mm)</th>
<th>Article number 1FL60</th>
<th>Article number 6SL321 0-5</th>
<th>Frame size</th>
<th>Article number 6FX3002-5</th>
<th>Article number 6FX3002-2</th>
<th>Article number 6FX3002-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.27</td>
<td>0.4</td>
<td>3000</td>
<td>45</td>
<td>42-1AF61-2</td>
<td>FE10-4UA0</td>
<td>CL02-1AD0 (3 m)</td>
<td>CL02-1AD0 (3 m)</td>
<td>-1AD0 (3 m)</td>
<td>-1AD0 (3 m)</td>
</tr>
<tr>
<td>2.39</td>
<td>0.75</td>
<td>3000</td>
<td></td>
<td>44-1AF61-2</td>
<td>FE10-8UA0</td>
<td>CL02-1AF0 (5 m)</td>
<td>CL02-1AF0 (5 m)</td>
<td>-1AF0 (5 m)</td>
<td>-1AF0 (5 m)</td>
</tr>
<tr>
<td>3.58</td>
<td>0.75</td>
<td>2000</td>
<td>65</td>
<td>61-1AC61-2</td>
<td>FE11-0UA0</td>
<td>CL02-1AH0 (7 m)</td>
<td>CL02-1AH0 (7 m)</td>
<td>-1AH0 (7 m)</td>
<td>-1AH0 (7 m)</td>
</tr>
<tr>
<td>4.78</td>
<td>1.0</td>
<td>2000</td>
<td></td>
<td>62-1AC61-2</td>
<td>FE11-0UA0</td>
<td>CL02-1BA0 (10 m)</td>
<td>CL02-1BA0 (10 m)</td>
<td>-1BA0 (10 m)</td>
<td>-1BA0 (10 m)</td>
</tr>
<tr>
<td>7.16</td>
<td>1.5</td>
<td>2000</td>
<td></td>
<td>64-1AC61-2</td>
<td>FE11-5UA0</td>
<td>CL12-1AD0 (3 m)</td>
<td>CL12-1AD0 (3 m)</td>
<td>-1AD0 (3 m)</td>
<td>-1AD0 (3 m)</td>
</tr>
<tr>
<td>8.36</td>
<td>1.75</td>
<td>2000</td>
<td></td>
<td>66-1AC61-2</td>
<td>FE12-0UA0</td>
<td>CL12-1AF0 (5 m)</td>
<td>CL12-1AF0 (5 m)</td>
<td>-1AF0 (5 m)</td>
<td>-1AF0 (5 m)</td>
</tr>
<tr>
<td>9.55</td>
<td>2.0</td>
<td>2000</td>
<td></td>
<td>67-1AC61-2</td>
<td>FE12-0UA0</td>
<td>CL12-1AH0 (7 m)</td>
<td>CL12-1AH0 (7 m)</td>
<td>-1AH0 (7 m)</td>
<td>-1AH0 (7 m)</td>
</tr>
<tr>
<td>11.9</td>
<td>2.5</td>
<td>2000</td>
<td>90</td>
<td>90-1AC61-2</td>
<td>FE13-0UA0</td>
<td>CL12-1BA0 (10 m)</td>
<td>CL12-1BA0 (10 m)</td>
<td>-1BA0 (10 m)</td>
<td>-1BA0 (10 m)</td>
</tr>
<tr>
<td>16.7</td>
<td>3.5</td>
<td>2000</td>
<td></td>
<td>92-1AC61-2</td>
<td>FE13-5UA0</td>
<td>CL12-1BF0 (15 m)</td>
<td>CL12-1BF0 (15 m)</td>
<td>-1BF0 (15 m)</td>
<td>-1BF0 (15 m)</td>
</tr>
<tr>
<td>23.9</td>
<td>5.0</td>
<td>2000</td>
<td></td>
<td>94-1AC61-2</td>
<td>FE15-0UA0</td>
<td>CL12-1CA0 (20 m)</td>
<td>CL12-1CA0 (20 m)</td>
<td>-1CA0 (20 m)</td>
<td>-1CA0 (20 m)</td>
</tr>
<tr>
<td>33.4</td>
<td>7.0</td>
<td>2000</td>
<td></td>
<td>96-1AC61-2</td>
<td>FE17-0UA0</td>
<td>CL12-1CA0 (20 m)</td>
<td>CL12-1CA0 (20 m)</td>
<td>-1CA0 (20 m)</td>
<td>-1CA0 (20 m)</td>
</tr>
</tbody>
</table>

### Note

You can select a SINAMICS V90 servo drive for all the SIMOTICS S-1FL6 servo motors whose rated power values are equal to or smaller than that specified as matching with this servo drive in the table above.
2.1 Device combination
3.1 Working modes

When you start SINAMICS V-ASSISTANT, the following window appears for you to select a working mode:

![Select working mode window]

The functions of SINAMICS V-ASSISTANT vary with the working modes.

Online mode

SINAMICS V-ASSISTANT communicates with the target drive, which is connected with PC by a USB cable.

If you select the online mode, a list of all connected drives are displayed. Select the target drive and click the following button.

![OK button]

SINAMICS V-ASSISTANT automatically creates a new project to save all parameter settings from the target drive and enters the main window.

Note

If SINAMICS V-ASSISTANT fails to detect the connected drive(s) immediately, please wait for a while and then plug in the USB cable again.
Offline mode

SINAMICS V-ASSISTANT does not communicate with any connected drive.
Two options are available for your choice:

If you select the first option, you must select a drive from the following window:

Select the product type and firmware version from the drop-down lists respectively. Then select the article number of your desired drive. Click **OK** to save the factory settings of the selected drive to the new project and enter the main window; otherwise, click **Cancel** to return to the last step.

**Note**
To obtain the firmware version, you can view r29108 on BOP (Basic Operator Panel). For more information, see the SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions.
If you select the second option, you need to select an existing project in the following directory as the current project and enter the main window:

1. Default location: xxx/Siemens/V-ASSISTANT/Project
   xxx: SINAMICS V-ASSISTANT setup root directory
2. Only .prj format is available.

**Status indicators**

In the main window of SINAMICS V-ASSISTANT, the current working mode is indicated by the status indicators at the upper right of the main window:

- Online
- Offline

You can switch the working mode between the two modes. For more information, see Section "Switch menu (Page 31)."
User interface

3.1 Working modes

Compare parameters

When you switch the working mode from offline to online, the following question appears to remind you to save the current project:

![Question dialog box]

You can click **Yes** to save the project; otherwise, you can click **No** to abort saving.

Then SINAMICS V-ASSISTANT automatically compares all parameter settings between the current project and the connected drive:

![Parameters comparison table]

Reading parameters from drive 119
If any inconsistency is detected, the following window appears:

![Parameters comparison table]

Click the first button to upload all parameter values of the connected drive to the current project; otherwise, click the second button to upload all parameter values of the current project to the connected drive.
3.2 User interface - overview

Note
The above screenshot takes the user interface of SINAMICS V-ASSISTANT for V90 PN for example.
3.2 User interface - overview

Menu bar

The menu bar is located at the top of the user interface. You can find various commands and functions for basic operations of SINAMICS V-ASSISTANT. For more information, see Section "Menu bar (Page 26)".

Toolbar

The toolbar is located below the menu bar and provides direct access to the essential functions of SINAMICS V-ASSISTANT. For more information, see Section "Toolbar (Page 36)".

Task navigation

The task navigation mask contains tasks for users to fulfill. Each task consists of various functions which facilitate users to parameterize all functions of V90 drives and monitor or diagnose the drives. For more information, see Section "Task navigation (Page 39)".

Function pane

The function pane provides the user interface of each user task for users to implement related functions.

Alarm window

In online mode, the currently active faults and alarms are displayed in a list with their types, numbers and names; in offline mode, the alarm window is disabled. For more information, see Section "Alarm window (Page 37)".
3.3 Menu bar

3.3.1 Menu bar - overview

The menu bar lists the following menu items for users to manage the projects, switch the user interface language, or view the online help:

- Project menu (Page 26)
- Edit menu (Page 30)
- Switch menu (Page 31)
- Tools menu (Page 32)
- Help menu (Page 35)

3.3.2 Project menu

This menu item contains commands for creating, opening, saving, printing, or exiting from a project as well as switching the user interface language. You can choose any menu command here for project management.

- New project (Page 26)
- Open project (Page 27)
- Save project (Page 28)
- Save project as (Page 29)
- Print (Page 29)
- Language (Page 30)
- Exit (Page 30)

3.3.2.1 Project -> New project

When SINAMICS V-ASSISTANT is working in offline mode, you can use this menu command to create a new project. To proceed, see Section "Selecting drive (Page 42)".
3.3.2.2 Project -> Open project

When SINAMICS V-ASSISTANT is working in offline mode, you can use this menu command to open an existing project in the following window:

① Default location: xxx/Siemens/V-ASSISTANT/Project
   xxx: SINAMICS V-ASSISTANT setup root directory
② Only .prj format is available.
3.3.2.3  Project -> Save project

Online mode/offline mode

You can use this menu command to save the changed configuration to the current project. If this menu command is used for the first time, it is the same as "Project -> Save project as..." (Page 29). You can specify the file name and directory in the following window:

![Save as dialog box]

① Default location: xxx/Siemens/V-ASSISTANT/Project
   xxx: SINAMICS V-ASSISTANT setup root directory

② Only .prj format is available.
3.3.2.4  Project -> Save project as...

**Online mode/offline mode**

You can use this menu command to save the current project with a specified file name and directory in the following window:

![Save project as window](image)

- Default location: `xxx/Siemens/V-ASSISTANT/Project`
  - `xxx`: SINAMICS V-ASSISTANT setup root directory
- Only .prj format is available.

3.3.2.5  Project -> Print

**Online mode/offline mode**

You can use this menu command to print the user interface of the selected function from "Task navigation (Page 39)."
3.3 Menu bar

3.3.2.6  Project -> Language

**Online mode/offline mode**

You can use this menu command to switch the user interface language as desired. The default languages of SINAMICS V-ASSISTANT are English and Chinese. For installation packages of additional languages, visit this address [http://www.siemens.com/sinamics-v-assistant](http://www.siemens.com/sinamics-v-assistant). After you download the desired installation package to your PC and run it, you can switch the interface language to the corresponding one.

3.3.2.7  Project -> Exit

**Online mode/offline mode**

You can use this menu command to exit from SINAMICS V-ASSISTANT directly.

3.3.3  Edit menu

This menu contains commands for cutting, copying and editing the parameter values or technical data of the motor and drive.

- Cut (Page 30)
- Copy (Page 31)
- Paste (Page 31)

3.3.3.1  Edit -> Cut

This command deletes the selected objects, for example, the parameter values from the user interface, and then copies them to the clipboard.

Alternatively, you can use \(\text{X}\) from the toolbar.

**Note**

This menu command can only be used to modify the values in "Viewing all parameters" (Page 87).
3.3.3.2 Edit -> Copy

The command copies the selected objects, for example, parameter values, article number or the rated power of the drive or motor, to the clipboard.

Alternatively, you can use from the toolbar.

Note
You can only use this menu command on the following function panes:
- Selecting drive (Page 42)
- Selecting motor (Page 44)
- Viewing all parameters (Page 87)
- Signal (Page 90)

3.3.3.3 Edit -> Paste

This menu command copies the clipboard content to the input field. The copied content can be inserted at a position determined with a mouse click.

Alternatively, you can use from the toolbar.

Note
You can only use this menu command to modify the values in Viewing all parameters (Page 87).

3.3.4 Switch menu

This menu contains the following two commands for switching SINAMICS V-ASSISTANT between the online mode and offline mode.

- Go offline (Page 31)
- Go online (Page 31)

3.3.4.1 Switch -> Go offline

When SINAMICS V-ASSISTANT is working in online mode, you can use this menu command to switch it to offline mode.

Alternatively, you can use from the toolbar.

3.3.4.2 Switch -> Go online

When SINAMICS V-ASSISTANT is working in offline mode, you can use this menu command to switch it to online mode.

Alternatively, you can use from the toolbar.
### 3.3 Menu bar

#### 3.3.5 Tools menu

This menu contains the following menu commands:

- Tools -> Save parameters to ROM (Page 32)
- Tools -> Restart drive (Page 32)
- Tools -> Reset absolute encoder (Page 33)
- Tools -> Factory default (Page 33)
- Tools -> Upload parameters (Page 35)

#### 3.3.5.1 Tools -> Save parameters to ROM

You can use this menu command to save the parameters from RAM to ROM in the drive. The following window appears to display the saving process:

![Saving all parameters to drive ROM...](image)

Note: The drive is busy. Do not close this window!

Alternatively, you can use ![button](image) from the toolbar.

#### 3.3.5.2 Tools -> Restart drive

You can use this menu command to restart the drive. After you select this menu command, the following reminder appears:

![Question](image)

After the drive is restarted, the unsaved parameters will get lost. Are you sure you want to restart the drive?

If you click ![Yes](image), then the following information window appears:
Click OK and the drive is restarted successfully.

3.3.5.3 Tools -> Reset absolute encoder

In online mode, if you have connected SINAMICS V-ASSISTANT to a motor with an absolute encoder, you can use this menu command to set the current position of the absolute encoder as the reference point.

3.3.5.4 Tools -> Factory default

Online

Select this menu command and the following reminder appears:
If you click [Yes], then the following information window appears:

When the process is finished, this window disappears automatically.

If you click [No], this operation can be aborted.

**Offline**

Select this menu command and the following reminder appears:

If you click [Yes], after the parameters are reset to their factory defaults, the following information appears:

Click [OK] to close the information window. To save the project, see Section "Project -> Save project (Page 28)".

If you click [No], this operation can be aborted.
3.3.5.5 Tools -> Upload parameters

Note
This menu command is only available in online mode.

You can use this menu command to upload parameters from the drive to SINAMICS V-ASSISTANT. After you select this menu command, the following window appears to show the process:

After the process is complete, the values of the same parameters in SINAMICS V-ASSISTANT are overwritten by those in the drive automatically.

3.3.6 Help menu

The online help quickly provides you with information about drive selection, parameterization, commissioning and diagnostics of SINAMICS V-ASSISTANT.

- Help -> View help (Page 35)
- Help -> About SINAMICS V-ASSISTANT... (Page 36)

3.3.6.1 Help -> View help

You can use this menu command to display the content of SINAMICS V-ASSISTANT Online help.
3.3.6.2 Help -> About SINAMICS V-ASSISTANT...

You can use this menu command to display the following information window for SINAMICS V-ASSISTANT.

3.4 Toolbar

The icons of the toolbar provide quick access to the commands in the menu bar or functions from Task navigation (Page 39).

- New project (Page 26)
- Open project (Page 27)
- Save project (Page 28)
- Print (Page 29)
- Cut (Page 30)
- Copy (Page 31)
- Paste (Page 31)
- Go offline (Page 31)
- Go online (Page 31)
- Save parameters to ROM (Page 32)
### 3.5 Alarm window

#### Alarm window overview

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alarm type</td>
</tr>
<tr>
<td></td>
<td>1️⃣: Fault</td>
</tr>
<tr>
<td></td>
<td>1️⃣️: Alarm</td>
</tr>
<tr>
<td>2</td>
<td>Alarm number</td>
</tr>
<tr>
<td>3</td>
<td>Alarm name and description</td>
</tr>
<tr>
<td>4</td>
<td>Alarm value</td>
</tr>
<tr>
<td>5</td>
<td>Acknowledge All</td>
</tr>
<tr>
<td></td>
<td>Clears the faults in the buffer area of the drive</td>
</tr>
</tbody>
</table>

1️⃣ Faults have priority over alarms in display.

#### Note

To view the detailed information of an active fault/alarm, press F1 to call the corresponding online help.
3.6 Function keys and shortcuts

SINAMICS V-ASSISTANT provides function keys and shortcuts for frequently called functions.

Function keys in SINAMICS V-ASSISTANT

[F1] → Calls the context sensitive online help

[Ctrl+X] → Edit -> Cut (Page 30)

[Ctrl+C] → Edit -> Copy (Page 31)

[Ctrl+V] → Edit -> Paste (Page 31)
Note
The above screenshot takes the task navigation mask of SINAMICS V-ASSISTANT for V90 PN for example.
<table>
<thead>
<tr>
<th>Task</th>
<th>Sub-functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting drive (Page 41)</td>
<td>• Selecting drive (Page 42)</td>
</tr>
<tr>
<td></td>
<td>• Selecting motor (Page 44)</td>
</tr>
<tr>
<td></td>
<td>• Control mode (Page 45)</td>
</tr>
<tr>
<td></td>
<td>• Jog (Page 47)</td>
</tr>
<tr>
<td>Setting PROFINET (V90 PN only) (Page 48)</td>
<td>• Selecting telegram (Page 48)</td>
</tr>
<tr>
<td></td>
<td>• Configuring network (Page 51)</td>
</tr>
<tr>
<td>Parameterizing (Page 52)</td>
<td>• Setting electronic gear ratio (V90 PTI only) (Page 53)</td>
</tr>
<tr>
<td></td>
<td>• Setting mechanism (Page 56)</td>
</tr>
<tr>
<td></td>
<td>• Setting parameter setpoint (Page 56)</td>
</tr>
<tr>
<td></td>
<td>• Configuring ramp function (V90 PN only) (Page 69)</td>
</tr>
<tr>
<td></td>
<td>• Setting limits (Page 71)</td>
</tr>
<tr>
<td></td>
<td>• Configuring inputs/outputs (Page 75)</td>
</tr>
<tr>
<td></td>
<td>• Configuring referencing (Page 78)</td>
</tr>
<tr>
<td></td>
<td>• Setting encoder pulse output (V90 PTI only) (Page 85)</td>
</tr>
<tr>
<td></td>
<td>• Backlash compensation (Page 85)</td>
</tr>
<tr>
<td></td>
<td>• Viewing all parameters (Page 87)</td>
</tr>
<tr>
<td>Commissioning (Page 90)</td>
<td>• Testing interface (Page 90)</td>
</tr>
<tr>
<td></td>
<td>• Testing motor (Page 107)</td>
</tr>
<tr>
<td></td>
<td>• Optimizing drive (Page 109)</td>
</tr>
<tr>
<td>Diagnostics (Page 122)</td>
<td>• Monitoring status (Page 122)</td>
</tr>
<tr>
<td></td>
<td>• Tracing signals (Page 123)</td>
</tr>
<tr>
<td></td>
<td>• Measuring machine (Page 127)</td>
</tr>
</tbody>
</table>
4.1 Selecting drive

Note
The above screenshot takes the task navigation mask of SINAMICS V-ASSISTANT for V90 PN for example.

<table>
<thead>
<tr>
<th>Area</th>
<th>Function</th>
<th>Description</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Drive selection</td>
<td>Selects a drive in this field</td>
<td>&quot;Selecting drive [Page 42]&quot;</td>
</tr>
<tr>
<td>②</td>
<td>Motor selection</td>
<td>Selects a motor in this field</td>
<td>&quot;Selecting motor [Page 44]&quot;</td>
</tr>
<tr>
<td>③</td>
<td>Control mode</td>
<td>Selects a control mode in this field</td>
<td>&quot;Control mode [Page 45]&quot;</td>
</tr>
<tr>
<td>④</td>
<td>Jog</td>
<td>Tests the Jog function in this field</td>
<td>&quot;Jog [Page 47]&quot;</td>
</tr>
</tbody>
</table>
4.1.1 Selecting drive

Online mode

When you choose to work in online mode, a list of connected drive type(s) is displayed for your selection:

Select the target drive type, and click OK to establish communication between SINAMICS V-ASSISTANT and the drive. SINAMICS V-ASSISTANT reads all parameter settings from the connected drive and the main window displays the drive information on the following panel:

The following drive information is displayed:

- Article number
- Line supply
- Rated power
- Rated current

**Note**

Select drive is disabled in online mode.

**Offline mode**

When you are working in offline mode, SINAMICS V-ASSISTANT does not communicate with the connected drive(s).

You can click Select drive to change the drive type in the following window:

![Drive Selection Window](image)

Select the article number of the target drive. Click OK to save the factory settings of the selected drive to the new project and enter the main window; or otherwise, click Cancel to exit.
4.1.2 Selecting motor

Online mode

- If the connected motor is equipped with an absolute encoder, Select motor is disabled.

Note

In the article number, "x" is a wildcard; for more information about "A\G", see the SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions.

- If the connected motor is equipped with an incremental encoder, click Select motor and the motor list is displayed.
Select a motor from the list and click the following button to confirm your selection:

Note
You can click "name plate" in the above window to see the specific location of the name plate on the motor.

Offline mode

- If you choose to create a new project, you need to select a drive first, then the information of the default motor is displayed.
- If you choose to open an existing project, the saved motor information is displayed.
- If you switch from online mode to offline mode, you can select the motor by clicking "Select motor".

4.1.3 Control mode

Online mode/offline mode

Totally, eleven control modes are available for V90 drives:

<table>
<thead>
<tr>
<th>Control mode</th>
<th>V90 PN</th>
<th>V90 PTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic control mode</td>
<td>• Speed control mode (S) (^1)</td>
<td>• Pulse train input position control mode (PTI) (^2)</td>
</tr>
<tr>
<td></td>
<td>• Basic positioner control mode (EPOS)</td>
<td>• Internal position control mode (IPos)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Speed control mode (S)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Torque control mode (T)</td>
</tr>
<tr>
<td>Compound control mode</td>
<td>-</td>
<td>• Control change mode: PTI/S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Control change mode: IPos/S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Control change mode: PTI/T</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Control change mode: IPos/T</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Control change mode: S/T</td>
</tr>
</tbody>
</table>

\(^1\) Default control mode for V90 PN, different from S control mode for V90 PTI
\(^2\) Default control mode for V90 PTI
### Apply a control mode

After you select a control mode, the following warning message appears:

![Question dialog box]

- **Online mode**

  Click **Yes** and the following message appears:

  ![Question dialog box]

  Click **Yes** to save all the parameters to ROM and reset the drive. Otherwise, click the following button or directly close the dialog box, and the drive can continue to work in the current control mode.

- **Offline mode**

  Click **Yes** and the control mode is changed.
4.1.4 Jog

Jog function is only available in online mode. You can configure this function on the following panel:

![Jog Panel]

- To start the Jog function, enter the Jog speed first. Click \( \text{Servo on} \), then the following warning appears:

![Warning]

Click \( \text{OK} \) and run the drive counter-clockwise/clockwise by clicking the following two buttons respectively:

![Jog Buttons]

Then the actual speed, actual torque, actual current and actual utilization are displayed.

- To stop the Jog function, click \( \text{Servo off} \) in the following window and SINAMICS V-ASSISTANT releases the control priority.

![Stoped Jog Panel]

**Note**

The Jog speed can not be too fast. Otherwise, the machine axes can get out of control due to possible communication delay.
4.2 Setting PROFINET (V90 PN only)

You can select the desired telegram and configure the network with this function.

4.2.1 Selecting telegram

In this area, you can see the activated control mode and telegram. If you desire to change the telegram, you can click the drop-down list and select the desired telegram.

After you select a new telegram, the displayed process data changes according to the selected telegram. You can view all the PZDs of the selected telegram with the drop-down list and read their hexadecimal values from the first row of the table.
The PZD in green indicates that it has a bit definition. You can read the binary value of each bit from the table.

**Supported telegrams**

SINAMICS V90 PN supports standard telegrams and Siemens telegrams for speed control mode. You can select the desired telegram with parameter p0922. See the following table for details.

From the perspective of the drive unit, the received process data represents the receive words and the process data to be sent to the send words.

<table>
<thead>
<tr>
<th>Telegram</th>
<th>Maximum number of PZD</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Receive word</td>
<td>Send word</td>
</tr>
<tr>
<td>Standard telegram 1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Standard telegram 2</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Standard telegram 3</td>
<td>5</td>
<td>9</td>
</tr>
<tr>
<td>Standard telegram 5</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>Standard telegram 7</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Standard telegram 9</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>Siemens telegram 102</td>
<td>6</td>
<td>10</td>
</tr>
<tr>
<td>Siemens telegram 105</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Standard telegram 110</td>
<td>12</td>
<td>7</td>
</tr>
<tr>
<td>Standard telegram 111</td>
<td>12</td>
<td>12</td>
</tr>
</tbody>
</table>

One PZD = one word

Standard telegram 5 and Siemens telegram 105 can only be used when the V90 PN connects to the SIMATICS S7-1500 and the TIA Portal version is V14 or higher.
### Telegrams used for speed control mode

<table>
<thead>
<tr>
<th>Telegram</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>5</th>
<th>102</th>
<th>105</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appl. class</td>
<td>1</td>
<td>1</td>
<td>1, 4</td>
<td>4</td>
<td>1, 4</td>
<td>4</td>
</tr>
<tr>
<td>PZD1</td>
<td>STW1</td>
<td>ZSW1</td>
<td>STW1</td>
<td>ZSW1</td>
<td>STW1</td>
<td>ZSW1</td>
</tr>
<tr>
<td>PZD2</td>
<td>NSOLL_A</td>
<td>NIST_B</td>
<td>NSOLL_B</td>
<td>NIST_B</td>
<td>NSOLL_B</td>
<td>NIST_B</td>
</tr>
<tr>
<td>PZD5</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
</tr>
<tr>
<td>PZD6</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
</tr>
<tr>
<td>PZD7</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
</tr>
<tr>
<td>PZD8</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
<td>STW2</td>
<td>ZSW2</td>
</tr>
</tbody>
</table>

### Telegrams used for basic positioner control mode

<table>
<thead>
<tr>
<th>Telegram</th>
<th>7</th>
<th>9</th>
<th>110</th>
<th>111</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appl. class</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>PZD1</td>
<td>STW1</td>
<td>ZSW1</td>
<td>STW1</td>
<td>ZSW1</td>
</tr>
<tr>
<td>PZD2</td>
<td>SATZANW</td>
<td>AKTSATZ</td>
<td>SATZANW</td>
<td>AKTSATZ</td>
</tr>
<tr>
<td>PZD3</td>
<td>STW2</td>
<td>ZSW2</td>
<td>POS_STW</td>
<td>POS_ZSW</td>
</tr>
<tr>
<td>PZD4</td>
<td>MDI_TARPOS</td>
<td>XIST_A</td>
<td>STW2</td>
<td>ZSW2</td>
</tr>
<tr>
<td>PZD5</td>
<td>MDI_VELOCITY</td>
<td>MDI_TARPOS</td>
<td>XIST_A</td>
<td>MDI_TARPOS</td>
</tr>
<tr>
<td>PZD6</td>
<td>MDI_ACC</td>
<td>MDI_VELOCITY</td>
<td>MDI_ACC</td>
<td>MDI_VELOCITY</td>
</tr>
<tr>
<td>PZD8</td>
<td>MDI_MOD</td>
<td>MDI_ACC</td>
<td>MDI_MOD</td>
<td>MDI_ACC</td>
</tr>
<tr>
<td>PZD10</td>
<td>MDI_MODE</td>
<td>MDI_MODE</td>
<td>user</td>
<td>user</td>
</tr>
</tbody>
</table>

1) PZD12 of telegram 111 is used to configure the user-defined function.
4.2.2 Configuring network

This function is only available in online mode. You can configure this function on the following panel:

In online mode, the IP address of the connected drive is displayed in area "②" automatically. You can define the PN name of station in area "①". Note that only numbers (0 to 9), lowercase letters ("a" to "z") and characters ("-" and ".") in English are permissible. In addition, you can modify the IP address in area "②" as desired. Click button "③" to save and activate the settings. Restart the drive and then the PN name and IP address you set become active and appear in areas "④" and "⑤".

**Note**

If you have also configured the IP protocol in TIA portal, then the IP protocol set in TIA portal takes the first priority and displays in area "⑤" as the actual active IP protocol.
4.3 Parameterizing

Note
The above screenshot takes the parameterizing panel of SINAMICS V-ASSISTANT for V90 PN for example.

Totally, ten sub-functions are available. The sub-function combinations vary with the drive variant and control modes:

<table>
<thead>
<tr>
<th>Sub-function</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>V90 PN</td>
</tr>
<tr>
<td>Setting electronic gear ratio (V90 PTI only)</td>
<td>✓</td>
</tr>
<tr>
<td>Setting mechanism</td>
<td>✓</td>
</tr>
<tr>
<td>Setting parameter setpoint</td>
<td>✓</td>
</tr>
<tr>
<td>Configuring ramp function (V90 PN only)</td>
<td>✓</td>
</tr>
<tr>
<td>Setting limits</td>
<td>✓</td>
</tr>
</tbody>
</table>
### 4.3.1 Setting electronic gear ratio (V90 PTI only)

#### 4.3.1.1 Overview

Setting electronic gear ratio is only available in pulse train input position control mode (PTI).

Select one of the following options for setting electronic gear ratio:

1. **Input the electronic gear ratio manually (the range of electronic gear ratio is 0.02~200)**
   
   \[
   \text{Electronic gear ratio} = \frac{\text{p29012}}{\text{p29013}}
   \]

2. **Number of setpoint pulses per motor revolution**
   
   \[
   \text{p29011}
   \]

3. **Calculate the electronic gear ratio by selecting the mechanical structure**
   
   - Ball screw
   - Disc table
   - Belt pulley
   - Rack and pinion
   - Roll feed
### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>When number of setpoint pulses per motor revolution (p29011) is 0, configure electronic gear ratio by setting numerator (p29012) and denominator (p29013).</td>
</tr>
<tr>
<td>②</td>
<td>When number of setpoint pulses per motor revolution is not 0, enter the number of setpoint pulses per motor revolution here.</td>
</tr>
</tbody>
</table>
| ③      | Calculate the electronic gear ratio according to different mechanical structures. Totally, five mechanical structures are available:  
  - Ball screw  
  - Disc table  
  - Belt pulley  
  - Rack and pinion  
  - Roll feed  

For more information, see Section "Mechanical structure (Page 54)". Enter the pitch value and gear ratio, select a display unit and click **Calculate**. Then the electronic gear ratio can be calculated automatically.

### 4.3.1.2 Mechanical structure

#### Variables

Configure variables according to the selected mechanical structure:

<table>
<thead>
<tr>
<th>Mechanical structure</th>
<th>Graphical view</th>
<th>Variable setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Variable</td>
</tr>
<tr>
<td><strong>Ball screw</strong></td>
<td><img src="image" alt="Ball screw" /></td>
<td>P: Pitch value (mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N: Load revolutions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M: Motor revolutions</td>
</tr>
<tr>
<td><strong>Disc table</strong></td>
<td><img src="image" alt="Disc table" /></td>
<td>N: Load revolutions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M: Motor revolutions</td>
</tr>
<tr>
<td><strong>Belt pulley</strong></td>
<td><img src="image" alt="Belt pulley" /></td>
<td>D: Diameter (mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N: Load revolutions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M: Motor revolutions</td>
</tr>
<tr>
<td>Mechanical structure</td>
<td>Graphical view</td>
<td>Variable setting</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Rack and pinion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>D: Diameter (mm) 0.0001 to 2147000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N: Load revolutions 1 to 2147000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M: Motor revolutions 1 to 2147000000</td>
</tr>
<tr>
<td>Roll feed</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>D: Diameter (mm) 0.0001 to 2147000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N: Load revolutions 1 to 2147000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M: Motor revolutions 1 to 2147000000</td>
</tr>
</tbody>
</table>

**Unit**

After configuring the variables for the selected mechanical structure, you must select one of the following units and input values within the scope:

- **Length unit**
  - Range: 0.0001 to 2147000000
- **Axis movement per load revolution**
  - Range: 1 to 2147000000

**Calculation**

Click **Calculate** to calculate the electronic gear ratio and the calculated result is displayed as the following example:

![Calculation Example](image)

**Note**

If either the numerator or the denominator of the electronic gear ratio is larger than 10000, the ratio can be reduced automatically to make them smaller than 10000.
4.3.2 Setting mechanism

By parameterizing the mechanical system, you can establish the link between the physical moving part and the length unit (LU). Select the mechanical structure and then set the gearbox factor as well as the length unit per revolution of the load on the following panel:

![Setting mechanism panel]

The unit of the fixed position setpoint is the Length Unit (LU). All subsequent position setpoint, related speed value, and acceleration value take LU as their unit in IPos control mode.

Taking a ball screw system for example, if the system has a pitch of 10 mm/revolution, then the resolution of the length unit should be 1 µm (1 LU = 1 µm). Therefore, one load revolution corresponds to 10000 LU (p29247 = 10000).

4.3.3 Setting parameter setpoint

Setting parameter setpoint is used to specify parameters related to speed, torque and position.

Depending on the current control mode, you can configure parameters of the following sub-functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>V90 PN</th>
<th>V90 PTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal form selection</td>
<td>EPOS</td>
<td>PTI</td>
</tr>
<tr>
<td>Position setpoint</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Position reached window setting</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

(Please refer to Page 57 for more details.)


<table>
<thead>
<tr>
<th>Function</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>V90 PN</td>
</tr>
<tr>
<td>Fixed position setpoint</td>
<td>EPOS</td>
</tr>
<tr>
<td>Speed setpoint</td>
<td>✓</td>
</tr>
<tr>
<td>Ramp-function generator</td>
<td>✓</td>
</tr>
<tr>
<td>Speed reached window</td>
<td>✓</td>
</tr>
<tr>
<td>Torque setpoint</td>
<td>✓</td>
</tr>
<tr>
<td>EPOS setpoint settings</td>
<td>✓</td>
</tr>
</tbody>
</table>

When SINAMICS V-ASSISTANT is in compound control modes, for how to set the parameter setpoint, refer to the settings in basic control modes.

### 4.3.3.1 Position setpoint

#### Position setpoint

The position setpoint function varies with the control modes. You can set the position setpoint on the corresponding panels in each control mode.

#### Setting the position setpoint in PTI control mode

In PTI control mode, you can select one signal to link with pulse train input from the following options:

Select the signal level on the following panels:

For more information, see Section "Pulse train inputs (PTIs) (Page 107)".
Setting the position setpoint in IPos control mode

In IPos control mode, you must specify the position setpoint on the following panel:

- Linear axis has a restricted traversing range and it is the factory setting of the SINAMICS V90 servo drive.
- Modular axis has an unrestricted traversing range.

You can directly enter the digital value in the cells for the following items:

- Position
- Speed
- Acceleration
- Deceleration

The current active position setpoint channel is displayed at the bottom of this panel. The channels correspond with p2617 and p2618 as follows:

<table>
<thead>
<tr>
<th>Position setpoint channel</th>
<th>Index of p2617</th>
<th>Index of p2618</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
</tbody>
</table>
Source for internal position setpoint

Eight position setpoints in total are available. Each position setpoint comes from one group of position data:

<table>
<thead>
<tr>
<th>Fixed position setpoint</th>
<th>Corresponding parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Parameter</td>
</tr>
<tr>
<td>Fixed position setpoint 1</td>
<td>p2617[0]</td>
</tr>
<tr>
<td></td>
<td>p2618[0]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td>Fixed position setpoint 2</td>
<td>p2617[1]</td>
</tr>
<tr>
<td></td>
<td>p2618[1]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td></td>
<td>p2618[2]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td></td>
<td>p2618[3]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td></td>
<td>p2618[4]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td></td>
<td>p2618[5]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td>Fixed position setpoint 7</td>
<td>p2617[6]</td>
</tr>
<tr>
<td></td>
<td>p2618[6]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
<tr>
<td>Fixed position setpoint 8</td>
<td>p2617[7]</td>
</tr>
<tr>
<td></td>
<td>p2618[7]</td>
</tr>
<tr>
<td></td>
<td>p2572</td>
</tr>
<tr>
<td></td>
<td>p2573</td>
</tr>
</tbody>
</table>
Setting the position setpoint in EPOS control mode

Three working modes are available for your selection. Whatever mode you select, the actual velocity is affected by the maximum acceleration and deceleration. You can enter the desired maximum acceleration and deceleration in areas ① and ② respectively.

Configure your desired working mode on the corresponding panel:

- **Traversing block**
A total of 16 position setpoints are available. Each position setpoint comes from one group of position data:

<table>
<thead>
<tr>
<th>Basic position setpoint</th>
<th>Corresponding parameters</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic position setpoint 1</td>
<td></td>
<td>p2617[0]</td>
<td>EPOS traversing block position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2618[0]</td>
<td>EPOS traversing block velocity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2619[0]</td>
<td>EPOS traversing block acceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2620[0]</td>
<td>EPOS traversing deceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2621[0]</td>
<td>EPOS traversing block task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2622[0]</td>
<td>EPOS traversing block task parameter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2623[0]</td>
<td>EPOS traversing block task mode</td>
</tr>
<tr>
<td>Basic position setpoint 2</td>
<td></td>
<td>p2617[1]</td>
<td>EPOS traversing block position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2618[1]</td>
<td>EPOS traversing block velocity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2619[1]</td>
<td>EPOS traversing block acceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2620[1]</td>
<td>EPOS traversing deceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2621[1]</td>
<td>EPOS traversing block task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2622[1]</td>
<td>EPOS traversing block task parameter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2623[1]</td>
<td>EPOS traversing block task mode</td>
</tr>
<tr>
<td>Basic position setpoint 3</td>
<td></td>
<td>p2617[2]</td>
<td>EPOS traversing block position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2618[2]</td>
<td>EPOS traversing block velocity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2619[2]</td>
<td>EPOS traversing block acceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2620[2]</td>
<td>EPOS traversing deceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2621[2]</td>
<td>EPOS traversing block task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2622[2]</td>
<td>EPOS traversing block task parameter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2623[2]</td>
<td>EPOS traversing block task mode</td>
</tr>
<tr>
<td>Basic position setpoint 4</td>
<td></td>
<td>p2617[3]</td>
<td>EPOS traversing block position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2618[3]</td>
<td>EPOS traversing block velocity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2619[3]</td>
<td>EPOS traversing block acceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2620[3]</td>
<td>EPOS traversing deceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2621[3]</td>
<td>EPOS traversing block task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2622[3]</td>
<td>EPOS traversing block task parameter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2623[3]</td>
<td>EPOS traversing block task mode</td>
</tr>
<tr>
<td>Basic position setpoint 5</td>
<td></td>
<td>p2617[4]</td>
<td>EPOS traversing block position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2618[4]</td>
<td>EPOS traversing block velocity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2619[4]</td>
<td>EPOS traversing block acceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2620[4]</td>
<td>EPOS traversing deceleration override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2621[4]</td>
<td>EPOS traversing block task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2622[4]</td>
<td>EPOS traversing block task parameter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p2623[4]</td>
<td>EPOS traversing block task mode</td>
</tr>
<tr>
<td>Basic position setpoint</td>
<td>Corresponding parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 6</td>
<td>p2617[5] EPOS traversing block position</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[5] EPOS traversing block velocity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[5] EPOS traversing block acceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[5] EPOS traversing deceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[5] EPOS traversing block task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[5] EPOS traversing block task parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[5] EPOS traversing block task mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 7</td>
<td>p2617[6] EPOS traversing block position</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[6] EPOS traversing block velocity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[6] EPOS traversing block acceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[6] EPOS traversing deceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[6] EPOS traversing block task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[6] EPOS traversing block task parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[6] EPOS traversing block task mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 8</td>
<td>p2617[7] EPOS traversing block position</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[7] EPOS traversing block velocity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[7] EPOS traversing block acceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[7] EPOS traversing deceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[7] EPOS traversing block task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[7] EPOS traversing block task parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[7] EPOS traversing block task mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 9</td>
<td>p2617[8] EPOS traversing block position</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[8] EPOS traversing block velocity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[8] EPOS traversing block acceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[8] EPOS traversing deceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[8] EPOS traversing block task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[8] EPOS traversing block task parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[8] EPOS traversing block task mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 10</td>
<td>p2617[9] EPOS traversing block position</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[9] EPOS traversing block velocity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[9] EPOS traversing block acceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[9] EPOS traversing deceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[9] EPOS traversing block task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[9] EPOS traversing block task parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[9] EPOS traversing block task mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 11</td>
<td>p2617[10] EPOS traversing block position</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[10] EPOS traversing block velocity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[10] EPOS traversing block acceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[10] EPOS traversing deceleration override</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[10] EPOS traversing block task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[10] EPOS traversing block task parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[10] EPOS traversing block task mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint</td>
<td>Corresponding parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Parameter</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[11]</td>
<td>EPOS traversing block task mode</td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 13</td>
<td>p2617[12]</td>
<td>EPOS traversing block position</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[12]</td>
<td>EPOS traversing block velocity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[12]</td>
<td>EPOS traversing block acceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[12]</td>
<td>EPOS traversing deceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[12]</td>
<td>EPOS traversing block task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[12]</td>
<td>EPOS traversing block task parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[12]</td>
<td>EPOS traversing block task mode</td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 14</td>
<td>p2617[13]</td>
<td>EPOS traversing block position</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[13]</td>
<td>EPOS traversing block velocity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[13]</td>
<td>EPOS traversing block acceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[13]</td>
<td>EPOS traversing deceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[13]</td>
<td>EPOS traversing block task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[13]</td>
<td>EPOS traversing block task parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[13]</td>
<td>EPOS traversing block task mode</td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 15</td>
<td>p2617[14]</td>
<td>EPOS traversing block position</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[14]</td>
<td>EPOS traversing block velocity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[14]</td>
<td>EPOS traversing block acceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[14]</td>
<td>EPOS traversing deceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[14]</td>
<td>EPOS traversing block task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[14]</td>
<td>EPOS traversing block task parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[14]</td>
<td>EPOS traversing block task mode</td>
<td></td>
</tr>
<tr>
<td>Basic position setpoint 16</td>
<td>p2617[15]</td>
<td>EPOS traversing block position</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2618[15]</td>
<td>EPOS traversing block velocity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2619[15]</td>
<td>EPOS traversing block acceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2620[15]</td>
<td>EPOS traversing deceleration override</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2621[15]</td>
<td>EPOS traversing block task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2622[15]</td>
<td>EPOS traversing block task parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p2623[15]</td>
<td>EPOS traversing block task mode</td>
<td></td>
</tr>
</tbody>
</table>
If you desire to configure the task settings of the traversing block, you can click to open the following window:

Click to expand the drop-down lists. Select your desired type of 2621, positioning mode, continuation condition as well as IDs and then close the window.

- **EPOS Jog**

Enter the desired traversing distance and velocity setpoint for Jog 1 or Jog 2 in the above window.

- **MDI Positioning**

Enter the desired MDI position, MDI velocity, MDI acceleration override and MDI deceleration override of the fixed setpoint. Click to expand the drop-down lists of the MDI positioning type and absolute positioning direction. Select your desired settings and close the windows.
Position setpoint smoothing time setting

With the smoothing function, the position characteristics curve from the pulse train input setpoint can be transformed into an S-curve profile with a time constant specified in p2533.

Position reached window setting

Set parameter p2544 to specify the monitoring window for controller to decide whether the setpoint position is reached on the following panel:

For more information about signal INP, see Section "Digital inputs/outputs (DIs/Dos)" (Page 94).
4.3.3.2   Speed setpoint

Source of speed setpoint

Eight sources in total are available for speed setpoint. You can select one of them with the combination of digital input signals SPD1, SPD2 and SPD3:

<table>
<thead>
<tr>
<th>Digital signal</th>
<th>SPD3</th>
<th>SPD2</th>
<th>SPD1</th>
<th>Torque limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>External analog speed setpoint (analog input 1)</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>Fixed speed setpoint 1 (p1001)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Fixed speed setpoint 2 (p1002)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>Fixed speed setpoint 3 (p1003)</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Fixed speed setpoint 4 (p1004)</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>Fixed speed setpoint 5 (p1005)</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>Fixed speed setpoint 6 (p1006)</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Fixed speed setpoint 7 (p1007)</td>
</tr>
</tbody>
</table>

Ramp-function generator

The ramp-function generator is used to limit acceleration in the event of abrupt setpoint changes and thus helps prevent load surges during drive operation.

The ramp-up time p1120 and ramp-down time p1121 can be used to set acceleration and deceleration ramps separately. This allows a smoothed transition in the event of setpoint changes.
Two types of ramp-function generator are available. You can specify the parameters on the corresponding panels:

- **Basic ramp-function generator**

- **Extended ramp-function generator**
Speed reached window

Set parameter p29078 for controller to decide whether the setpoint speed is reached on the following panel:

4.3.3.3 Torque setpoint
Source of torque setpoint

Two sources are available for torque setpoint:

- External setpoint: analog input 2
- Fixed setpoint: p29043

You can select these two sources with the digital input signal TSET:

<table>
<thead>
<tr>
<th>Signal</th>
<th>Level</th>
<th>Source of torque setpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSET</td>
<td>0 (default)</td>
<td>Analog torque setpoint (analog input 2)</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Fixed torque setpoint (p29043)</td>
</tr>
</tbody>
</table>

4.3.4 Configuring ramp function (V90 PN only)

Ramp-function generator

The ramp-function generator is used to limit acceleration in the event of abrupt setpoint changes and thus helps prevent load surges during drive operation.

The ramp-up time p1120 and ramp-down time p1121 can be used to set acceleration and deceleration ramps separately. This allows a smoothed transition in the event of setpoint changes.

To activate this function, select "②" from the drop-down list in the above window or set bit 0 of p29108 on the BOP first. Make sure you have properly connected the SINAMICS V90 PN drive with the motor and the encoder works normally; otherwise, the ramp function generator is disabled due to faults (for example, F31117 and F52983, etc.) despite that it is displayed active in the above window. To activate the internal configuration of the ramp function generator, you have to re-connect the motor and restart the drive. Then, you can continue with either type of the ramp function generator.
Two types of ramp-function generator are available. You can specify the parameters on the corresponding panels:

- **Basic ramp-function generator**

![Basic ramp-function generator diagram]

- **Extended ramp-function generator**

![Extended ramp-function generator diagram]
4.3.5 Setting limits

You can configure speed limit, torque limit and software position limit with this function. The sub-functions vary with the selected control mode as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>V90 PN</td>
</tr>
<tr>
<td></td>
<td>EPOS</td>
</tr>
<tr>
<td>Torque limit (Page 71)</td>
<td>✓</td>
</tr>
<tr>
<td>Overall torque limit</td>
<td>✓</td>
</tr>
<tr>
<td>Speed limit (Page 73)</td>
<td>✓</td>
</tr>
<tr>
<td>Overall speed limit</td>
<td>✓</td>
</tr>
<tr>
<td>Software Position limit (Page 84)</td>
<td>✓</td>
</tr>
</tbody>
</table>

4.3.5.1 Torque limit

Torque limit is available in PTI, IPos, S and EPOS control modes.

You can specify the corresponding parameters on the following panels:

- In S (V90 PN) and EPOS control modes:

![Torque limit - V90 PN and EPOS control modes](image)

- In S (V90 PTI), PTI and IPos control modes:

![Torque limit - S (V90 PTI), PTI and IPos control modes](image)
Source of torque limit

- **SINAMICS V90 PN**
  Two sources in total are available for torque limit. You can select one of them via the digital input signal TLIM:

<table>
<thead>
<tr>
<th>Digital input (TLIM)</th>
<th>Torque limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Internal torque limit 1</td>
</tr>
<tr>
<td>1</td>
<td>Internal torque limit 2</td>
</tr>
</tbody>
</table>

When the torque setpoint reaches torque limit, the torque is limited to the value selected by TLIM.

**Note**
You can switch between the two sources and modify their values when the servo drive is running.

For more information about the digital input signal TLIM, see Section "DIs (Page 94)":

- **SINAMICS V90 PTI**
  Four sources in total are available for torque limit. You can select one of them via a combination of digital input signals TLIM1 and TLIM2:

<table>
<thead>
<tr>
<th>Digital signal</th>
<th>Torque limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLIM2, TLIM1</td>
<td></td>
</tr>
<tr>
<td>0, 0</td>
<td>Internal torque limit 1</td>
</tr>
<tr>
<td>0, 1</td>
<td>External torque limit (analog input 2)</td>
</tr>
<tr>
<td>1, 0</td>
<td>Internal torque limit 2</td>
</tr>
<tr>
<td>1, 1</td>
<td>Internal torque limit 3</td>
</tr>
</tbody>
</table>

When the torque setpoint reaches the torque limit, the torque is limited to the value selected by TLIM1/TLIM2.

**Note**
These four sources are valid in control modes PTI, IPos, and S. You can switch among them when the servo drive is running.

For more information about the digital input signals TLIM1 and TLIM2, see Section "DIs (Page 97)".
Overall torque limit

Besides the above sources, an overall torque limit is available in all control modes. The overall torque limit takes effect when an emergency stop (OFF3) happens. In this case, the servo drive brakes with a maximum torque.

In T mode, you can set the overall torque limit on the following panel:

```
Overall torque limit

Upper overall torque limit: 0.0000 Nm
Lower overall torque limit: 0.0000 Nm
```

4.3.5.2 Speed limit

Speed limit is available in PTI, IPos, S, T and EPOS control modes.

You can specify the corresponding parameters on the following panels:

- In S (V90 PN) and EPOS control modes:

```
Speed limit

Positive speed limit (rpm):
- 210000.0000

Negative speed limit (rpm):
- 210000.0000
```

- In S (V90 PTI), PTI, IPos and T control modes:

```
Speed limit

Positive speed limit (rpm):
- 210000.0000

Negative speed limit (rpm):
- 210000.0000
```
Source of speed Limit

- **SINAMICS V90 PN**
  Two sources in total are available for speed limit. You can select one of them via the digital input signal SLIM:

<table>
<thead>
<tr>
<th>Digital input (SLIM)</th>
<th>Speed limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Internal speed limit 1</td>
</tr>
<tr>
<td>1</td>
<td>Internal speed limit 2</td>
</tr>
</tbody>
</table>

  **Note**
  You can switch between the two sources and modify their values when the servo drive is running.

  When the speed setpoint reaches the speed limit, an alarm occurs.
  For more information about the digital input signal SLIM, see Section "DIs (Page 94)".

- **SINAMICS V90 PTI**
  Four sources in total are available for speed limit. You can select one of them via a combination of digital input signals SLIM1 and SLIM2:

<table>
<thead>
<tr>
<th>Digital signal</th>
<th>Speed limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLIM2</td>
<td>SLIM1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

  **Note**
  **Control mode**
  The above four sources are valid in all control modes for V90 PTI. You can switch among them when the servo drive is running.

  When the speed setpoint reaches the speed limit, an alarm occurs.
  For more information about the digital input signals SLIM1 and SLIM2, see Section "DIs (Page 97)".

  **Overall speed limit**
  Besides the above sources, an overall speed limit is available in all control modes.
4.3.6 Configuring inputs/outputs

Three sub-functions are available as follows:

- Assigning digital inputs (Page 75)
- Assigning digital outputs (Page 76)
- Assigning analog outputs (V90 PTI only) (Page 77)

4.3.6.1 Assigning digital inputs

You can assign digital inputs on the following panels:

- Assigning digital inputs for V90 PN

A total of four signals can be freely linked to digital inputs, for more information, see Section "DIs (Page 94)."

Click the cells with white background in the table. Two options are displayed in the drop-down list: Assign and Cancel. Select "Assign" to link the digital input with the corresponding signal. Then the current row displays grey. Otherwise, select "Cancel" to release the link. The current row then displays white.

- Assigning digital inputs for V90 PTI

A total of 28 signals can be freely linked to digital inputs except for DI9 and DI10 linked with E_Stop and C_Mode signals. For more information, see Section "DIs (Page 97)."

Click the cells with white background in the table. Two options are displayed in the drop-down list: Assign and Cancel. Select "Assign" to link the digital input with the corresponding signal. Then the current row displays grey. Otherwise, select "Cancel" to release the link. The current row then displays white.
You can activate the checkbox in column "Set to 1" to forcibly set the signal status to 1. For the signal EMGS, it can be forcibly set to 1 when the drive firmware version is V1.04.00 and higher.

**Note**

Signal P_TRG in PTI mode is reserved for future use.

### 4.3.6.2 Assigning digital outputs

You can assign digital outputs on the following panels:

- Assigning digital outputs for V90 PN

A total of seven signals can be freely linked to digital outputs. For more information, see Section "DOs (Page 95)".

Click the cells with white background in the table. Select "Assign" to link the digital input with the corresponding signal. Then the current cell displays grey.

**DO signal reverse**

You can reverse the logics of DO1 and DO2 by activating the checkboxes in the following function area or setting the bit 0 and bit 1 of parameter p748:

After the DO port is reversed, an "/" appears before the DO port to indicate that the logic of the signal assigned to this port has been reversed.
Assigning digital outputs for V90 PTI

A total of 14 signals can be freely linked to digital outputs. For more information, see Section "DOs (Page 102)".

Click the cells with white background in the table. Select "Assign" to link the digital input with the corresponding signal. Then the current cell displays grey.

**Note**

**DO signal inverse**

The logics of digital output signals DO1 to DO6 can be inversed. You can inverse the logics of DO1 to DO6 by setting the bit 0 to bit 5 of parameter P0748.

### 4.3.6.3 Assigning analog outputs (V90 PTI only)

You can assign analog outputs on the panel below:
 Seven signals in total can be linked with either analog output. For more information, see Section "Analog outputs (AOs)" (Page 106).

By default, analog output 1 and analog output 2 are linked with actual speed and actual torque respectively. You can freely select the target signal in the drop-down list to link with analog outputs.

4.3.7 Configuring referencing

Referencing is only available in IPos and EPOS control modes.

Two sub-functions are available:

- Setting referencing (Page 78)
- Setting software position limit (Page 84)

4.3.7.1 Setting referencing

Setting referencing is only available in online mode.

Setting referencing (in IPos control mode)

- Incremental encoder

If the motor is equipped with an incremental encoder, five referencing modes in total are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Referencing mode</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>p29240</td>
<td>0</td>
<td>Setting the reference point via digital input (signal REF)</td>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Referencing mode</td>
<td>Illustration</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>1</td>
<td>External reference cam (signal REF) and encoder zero mark</td>
<td></td>
<td><img src="image1.png" alt="Diagram 1" /></td>
</tr>
<tr>
<td>2</td>
<td>Encoder zero mark only</td>
<td></td>
<td><img src="image2.png" alt="Diagram 2" /></td>
</tr>
<tr>
<td>3</td>
<td>External reference cam (CCWL signal) and encoder zero mark</td>
<td></td>
<td><img src="image3.png" alt="Diagram 3" /></td>
</tr>
</tbody>
</table>
Taking the second referencing mode as an example, you can configure relevant parameters on the following panel:

Assign signals REF and SREF (for more information, see Section "Configuring inputs/outputs (Page 75)"). Click to start referencing and the following warning appears:

Click to start referencing and the following window appears:
To stop the referencing process, click the following button:

- **Stop referencing**

### Absolute encoder

If the motor is equipped with an absolute encoder, the five referencing modes are available. You can implement the referencing process via the Modbus or external DI terminals rather than the V-ASSISTANT.

If the motor is equipped with an absolute encoder, you can adjust the absolute encoder by clicking on the following panel to configure referencing:

- **Set referencing**

  - **Absolute value calibrating status**
  - **Absolute encoder not adjusted**

  - **Coordinate value of the reference point**

---

**Note**

**Referencing mode for the absolute encoder**

If an absolute encoder is connected, the five referencing modes are also available. You can select different referencing modes with the parameter p29240. When p29240 = 1 to 4, the referencing process can only be implemented before you set the current position as the zero position. Once the zero position is set, the four referencing modes are not available any more.
Setting referencing (in EPOS control mode)

You can view the current telegram in the header of this function mask.

- **Incremental encoder**

  If the motor is equipped with an incremental encoder, three referencing modes in total are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Referencing mode</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>p29240</td>
<td>0</td>
<td>Setting the reference point via digital input (signal REF)</td>
<td><img src="image1" alt="Illustration" /></td>
</tr>
</tbody>
</table>

**Note**
When setting the reference point via the digital input REF, you need to keep the control word STW1.11 = 0.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Referencing mode</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>External reference cam (signal REF) and encoder zero mark</td>
<td><img src="image2" alt="Illustration" /></td>
</tr>
</tbody>
</table>
Taking the second referencing mode as an example, you can configure the relevant parameters on the following panel:

Before starting referencing, check the sources of signals REF and SREF in the above illustration respectively. In this example, the source of signal REF is DI. See Section "Assigning digital inputs" (Page 75) for information on how to assign signal REF.

- **Absolute encoder**

  See the relevant description in Section "Setting referencing (in IPos control mode)" (Page 78).
4.3.7.2 Setting software position limit

Prerequisites

- Referencing is completed successfully.
- Linear axis working mode is selected.

Setting software position limit

The following two software position limits are available in IPos and EPOS control modes:

- positive position limit
- negative position limit

When the actual position reaches one of the above-mentioned software position limits, motor speed decelerates to 0.

You can set the software position limit on the following panel:

<table>
<thead>
<tr>
<th>Method 1: Setting through manual input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the check box to enable the software position limit. Enter the desired position values in the bottom input fields directly.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Method 2: Setting through the Jog function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the checkbox to enable the software position limit.</td>
</tr>
<tr>
<td>2. Enter the speed value.</td>
</tr>
</tbody>
</table>

**Note:**
The Jog speed can not be too fast. Otherwise, the machine axes can get out of control due to possible communication delay.
3. Click this button to execute servo-on and a warning message appears. Confirm your selection by clicking in the message window.

4. Click this button to rotate the motor clockwisely and set a proper limit position.

5. Obtain the current position by clicking this button.

6. Click this button to rotate the motor counter-clockwisely and set a proper limit position.

7. Obtain the current position by clicking this button.

8. If you desire to disable this function, you can click this button and the checkbox.

4.3.8 Setting encoder pulse output (V90 PTI only)

When SINAMICS V-ASSISTANT is working in position control modes (PTI and IPos), you can configure pulse output on the following panel:

SINAMICS V-ASSISTANT automatically identifies the encoder type and resolution. Two options are available for you to configure PTO relevant parameters:

- set PTO number per revolution
- set PTO number by gear ratio

4.3.9 Backlash compensation

Note

Prerequisites for backlash compensation

- The axis has been referenced for incremental measuring system. For more information about referencing, see Section "Setting referencing (in IPos control mode) (Page 78)."
- The axis has been adjusted for absolute measuring system.
Generally, backlash occurs when the mechanical force is transferred between a machine part and its drive.

If the mechanical system was to be adjusted/designated so that there was absolutely no backlash, this would result in high wear. Thus, backlash can occur between the machine component and the encoder. For axes with indirect position sensing, mechanical backlash results in a false traversing distance because the axis, at direction reversal, travels either too far or not far enough corresponding to the absolute value of the backlash.

You can configure the backlash compensation for V90 PTI on the following panel:

In order to compensate the backlash, the determined backlash must be specified in p2583 with correct polarity. At each direction of rotation reversal, the axis actual value is corrected dependent on the actual traversing direction.

**Note**

**Backlash compensation for V90 PN**

The backlash compensation pane for V90 PN is included in the function pane of "Set mechanism".
4.3.10 Viewing all parameters

You can configure all editable parameters in this field:

<table>
<thead>
<tr>
<th>Group</th>
<th>Parameter No.</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
<th>Range</th>
<th>Factory setting</th>
<th>Save changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>p748</td>
<td>CU invert digital outputs</td>
<td>00000000000H</td>
<td>N/A</td>
<td>--</td>
<td>00000000000H</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p5000</td>
<td>Motor ID</td>
<td>42</td>
<td>N/A</td>
<td>0</td>
<td>0</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50001</td>
<td>Reversal of motor direction</td>
<td>0</td>
<td>Direct</td>
<td>N/A</td>
<td>0</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50002</td>
<td>BOP display selection</td>
<td>0</td>
<td>Speed</td>
<td>N/A</td>
<td>0</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50003</td>
<td>Control mode</td>
<td>0</td>
<td>PTI</td>
<td>N/A</td>
<td>0</td>
<td>reset</td>
</tr>
<tr>
<td>Basic</td>
<td>p50004</td>
<td>RS485 address</td>
<td>1</td>
<td>N/A</td>
<td>[1.31]</td>
<td>1</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50005</td>
<td>Brake resistor capacity percent</td>
<td>100.0000</td>
<td>%</td>
<td>[1.100]</td>
<td>100.0000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50006</td>
<td>Line supply voltage</td>
<td>400</td>
<td>V</td>
<td>[200, 460]</td>
<td>400</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50007</td>
<td>RS485 protocol</td>
<td>1</td>
<td>USB prod</td>
<td>N/A</td>
<td>--</td>
<td>reset</td>
</tr>
<tr>
<td>Basic</td>
<td>p50008</td>
<td>Modbus control mode</td>
<td>2</td>
<td>No contr</td>
<td>N/A</td>
<td>--</td>
<td>2</td>
</tr>
<tr>
<td>Basic</td>
<td>p50009</td>
<td>RS485 baud rate</td>
<td>38400</td>
<td>N/A</td>
<td>--</td>
<td>0</td>
<td>reset</td>
</tr>
<tr>
<td>Basic</td>
<td>p50010</td>
<td>PTI: Selection of input pulse 0</td>
<td>P0_P</td>
<td>N/A</td>
<td>--</td>
<td>0</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50011</td>
<td>PTI: Number of setpoint pulse</td>
<td>0</td>
<td>N/A</td>
<td>[0.16777215]</td>
<td>0</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50012P</td>
<td>PTI: Numerator of electronic ge</td>
<td>1</td>
<td>N/A</td>
<td>[1.10000]</td>
<td>1</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50013</td>
<td>PTI: Denominator of electronic</td>
<td>1</td>
<td>N/A</td>
<td>[1.10000]</td>
<td>1</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50014</td>
<td>PTI: Selection of pulse input</td>
<td>24V</td>
<td>N/A</td>
<td>--</td>
<td>1</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50015</td>
<td>PTI: Pulse input filter</td>
<td>0</td>
<td>PTI_bar_f</td>
<td>N/A</td>
<td>--</td>
<td>0</td>
</tr>
<tr>
<td>Basic</td>
<td>p50016</td>
<td>RS485 monitor time</td>
<td>0.0000</td>
<td>ms</td>
<td>[0, 10000000]</td>
<td>0.0000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50017</td>
<td>Dynamic factor: One_p</td>
<td>18</td>
<td>N/A</td>
<td>[1.35]</td>
<td>18</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50018</td>
<td>Mode selection</td>
<td>0</td>
<td>Disable</td>
<td>N/A</td>
<td>--</td>
<td>0</td>
</tr>
<tr>
<td>Basic</td>
<td>p50019</td>
<td>Ratio of total inertia m</td>
<td>1.0000</td>
<td>N/A</td>
<td>[1.10000]</td>
<td>1.0000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50020</td>
<td>One-button auto tune</td>
<td>0007H</td>
<td>N/A</td>
<td>--</td>
<td>0007H</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50021</td>
<td>Real-time auto tune</td>
<td>004CH</td>
<td>N/A</td>
<td>--</td>
<td>004CH</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50022</td>
<td>Configuration overall</td>
<td>0044H</td>
<td>N/A</td>
<td>--</td>
<td>0044H</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50023</td>
<td>Test signal duration</td>
<td>2000</td>
<td>ms</td>
<td>[0, 5000]</td>
<td>2000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50024</td>
<td>Limit of motor rotation</td>
<td>0</td>
<td>*</td>
<td>[0, 3000]</td>
<td>0</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50025</td>
<td>Pre-control time const.</td>
<td>75000</td>
<td>ms</td>
<td>[0, 60]</td>
<td>75000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50026</td>
<td>Number of pulse per rev</td>
<td>1000</td>
<td>N/A</td>
<td>[0, 16384]</td>
<td>1000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50027</td>
<td>Numerator of electronic g</td>
<td>1</td>
<td>N/A</td>
<td>[1, 21479000]</td>
<td>1</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50028</td>
<td>Denominator of electronic g</td>
<td>1</td>
<td>N/A</td>
<td>[1, 21479000]</td>
<td>1</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50029</td>
<td>Direction change</td>
<td>0</td>
<td>PTI_pos</td>
<td>N/A</td>
<td>--</td>
<td>0</td>
</tr>
<tr>
<td>Basic</td>
<td>p50030</td>
<td>VIBUS activation</td>
<td>0</td>
<td>Disable</td>
<td>N/A</td>
<td>--</td>
<td>0</td>
</tr>
<tr>
<td>Basic</td>
<td>p50031</td>
<td>Torque scaling: Torque set scale</td>
<td>100.0000</td>
<td>%</td>
<td>[0.300]</td>
<td>100.0000</td>
<td>immediately</td>
</tr>
<tr>
<td>Basic</td>
<td>p50032</td>
<td>Offset adjustment for analog m</td>
<td>0.0000</td>
<td>V</td>
<td>[4.5, 0.5]</td>
<td>0.0000</td>
<td>immediately</td>
</tr>
</tbody>
</table>

**Note**

**Icons**

- ![This icon is only available for V90 PTI. A parameter with this icon in the above list indicates that it is related to Modbus communication. You can click on this icon to call the online help for Modbus communication.](image)

- ![Parameters with this icon in the above list indicate they are indexed parameters. By default, the first index of each indexed parameter is displayed. To view all indices of an indexed parameter, click on this icon.](image)

**Note**

**Can be changed**

The parameters can be changed in two states. You can see the attribute of each parameter in Section "Parameter list" in the online help. The online help can be called by pressing F1 key.

- U (Run): Can be changed in the "Running" state when the drive is in "S ON" state.
- T (Ready to run): Can be changed in the "Ready" state when the drive is in "S OFF" state.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group filter</td>
<td>Views parameters according to different groups.</td>
</tr>
<tr>
<td>Find</td>
<td>Filters the parameter list according to the entered text. The filtering is done after you enter the desired text. <strong>Note:</strong> If you enter the parameter number of an indexed parameter in the input field, all its indices can be displayed. To return to the view of all parameters, you only need to clear the entered text.</td>
</tr>
<tr>
<td>Factory default</td>
<td>You can click the following button to reset all parameters to their factory settings: Factory default For more information, see Section &quot;Tools -&gt; Factory default (Page 33)&quot;.</td>
</tr>
</tbody>
</table>
| Save changes  | You can click the following button to save the changes compared to the defaults/factory settings into an .html file and use the file for future documentation purposes or as an reference for BOP commissioning. Window for saving the changes:  

![Window for saving the changes](image)

①: Default location: xxx/Siemens/V-ASSISTANT/Project.  
xxx: SINAMICS V-ASSISTANT setup root directory  
②: Only .html format is available. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Table | All parameters are displayed with the following information:  
• Group  
• Parameter number  
• Name  
• Value  
• Unit  
• Range  
• Factory setting  
• Effect type  
**Note:**  
In the value relevant column, values with white background are editable. |
4.4 Commissioning

4.4.1 Testing interface

4.4.1.1 I/O simulation

When SINAMICS V-ASSISTANT is working in online mode, you can view the I/O status on the following panel for V90 PTI and V90 PN respectively:

- SINAMICS V90 PTI:
- **SINAMICS V90 PN:**

  ![Diagram](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| ①   | Pulse train input | Information about pulse train input:  
  - Received number of pulses  
  - Pulse frequency  
  For more information, see Section "Pulse train inputs (PTIs) (Page 107)". |
| ②   | SINAMICS V90 PTI |  
  DI1~DI8: Every digital input can be linked with either of the 28 internal signals.  
  DI9: Linked with EMGS signal  
  DI10: Linked with C_MODE signal  
  SINAMICS V90 PN:  
  DI1~DI4: Every digital input can be linked with either of the seven internal signals.  
  Note: For more information about the number and definition of signals, see Section "DIs (Page 94)". |
| ③   | AI1   | Linked with speed related signals  
  AI2   | Linked with torque related signals  
  Note: For more information about analog inputs, see Section "Analog inputs (AIs) (Page 105)". |
| ④   | AO1   | Linked with actual speed signal by default  
  AO2   | Linked with actual torque signal by default  
  Note: For more information, see Section "Analog outputs (AOs) (Page 106)". |
<table>
<thead>
<tr>
<th></th>
<th>SINAMICS V90 PTI</th>
<th>SINAMICS V90 PN</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DO1~DO6</td>
<td>DO1~DO2</td>
</tr>
<tr>
<td></td>
<td>Every digital output can be freely linked with either of the 15 internal signals.</td>
<td>Every digital output can be freely linked with either of the ten internal signals.</td>
</tr>
</tbody>
</table>

**Note:**

For more information, see Section "Digital inputs/outputs (DIs/Dos)" (Page 94).

<table>
<thead>
<tr>
<th></th>
<th>Clicking this button enables DO simulation. If you desire to disable this function, click the following button:</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td><img src="image" alt="Enable DO simulation" /> <img src="image" alt="Disable DO simulation" /></td>
</tr>
</tbody>
</table>

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td><img src="image" alt="Signal is enabled" /></td>
<td>Indicates that high-voltage (or logic 1) is on the digital input/output.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Signal is disabled" /></td>
<td>Indicates that low-voltage (or logic 0) is on the digital input/output.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Signal is forcibly set to 1" /></td>
<td>Indicates that the status of the assigned signal is forcibly set to 1.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="DO is reversed" /></td>
<td>Indicates that the logic of the DO is reversed. After the DO is reversed, a &quot;/'&quot; appears in front of the DO port.</td>
</tr>
</tbody>
</table>

**Note**

- This function is unavailable but can be displayed in offline mode.
- The status of each indicator and analog value is updated every 0.5 s.
- Signal P_TRG in PTI control mode is reserved for future use.
- You can change the signal link as desired. For more information, see Section "Configuring inputs/outputs" (Page 75).
Status of signals

You can view the name, description, value and status of individual signals on the following panels for V90 PTI and V90 PN respectively:

- **SINAMICS V90 PTI:**
  - Status of DI signals:
    - **SINAMICS V90 PN:**
      - Status of DI signals:
      - Status of DO signals:
4.4.1.2  Digital inputs/outputs (DIs/Dos)

DIs/Dos for SINAMICS V90 PN

DIs

You can assign a maximum of seven internal digital input signals to the SINAMICS V90 PN servo drive. For detailed information about these signals, see the table below:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESET</td>
<td>Edge</td>
<td>Reset alarms</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>0→1</td>
<td>• 0→1: reset alarms</td>
<td>✓</td>
</tr>
<tr>
<td>TLIM</td>
<td>Level</td>
<td>Torque limit selection</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can select two internal torque limit sources with the digital input signal TLIM.</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: internal torque limit 1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: internal torque limit 2</td>
<td>✓</td>
</tr>
<tr>
<td>SLIM</td>
<td>Level</td>
<td>Speed limit selection</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can select two internal speed limit sources with the digital input signal SLIM.</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: internal speed limit 1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: internal speed limit 2</td>
<td>✓</td>
</tr>
<tr>
<td>EMGS</td>
<td>Level</td>
<td>Emergency stop</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: emergency stop</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: servo drive is ready to run</td>
<td>✓</td>
</tr>
<tr>
<td>REF</td>
<td>Edge</td>
<td>Setting the reference point with a digital input or reference cam input for reference approaching mode</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>0→1</td>
<td>• 0→1: reference input</td>
<td>✓</td>
</tr>
<tr>
<td>CWL</td>
<td>Edge</td>
<td>Clockwise over-travel limit (positive limit)</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>1→0</td>
<td>• 1: condition for operation</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1→0: emergency stop (OFF3)</td>
<td>✓</td>
</tr>
<tr>
<td>CCWL</td>
<td>Edge</td>
<td>Counter-clockwise over-travel limit (negative limit)</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>1→0</td>
<td>• 1: condition for operation</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1→0: emergency stop (OFF3)</td>
<td>✓</td>
</tr>
</tbody>
</table>
Wiring

The digital inputs support both PNP and NPN types of wirings. You can find detailed information from the following diagrams:

DOs

You can assign a maximum of ten internal digital output signals to the SINAMICS V90 PN servo drive. For detailed information about these signals, see the table below:

<table>
<thead>
<tr>
<th>Name</th>
<th>Descriptions</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY</td>
<td>Servo ready</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 1: ready to operate</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 0: drive not ready (alarm occurs or enable signal is missing)</td>
<td>✓</td>
</tr>
<tr>
<td>Fault</td>
<td>Fault</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 1: in fault status</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 0: no fault</td>
<td>✓</td>
</tr>
<tr>
<td>ZSP</td>
<td>Zero speed detection</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 1: motor speed is equal with or lower than the zero speed (can be set with parameter p2161).</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 0: motor speed is higher than zero speed + hysteresis (10 rpm).</td>
<td>✓</td>
</tr>
<tr>
<td>TLR</td>
<td>Torque limit reached</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 1: the generated torque has nearly (internal hysteresis) reached the value of the positive torque limit, negative torque limit or analog torque limit</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• 0: the generated torque has not reached the limit</td>
<td>✓</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptions</td>
<td>Control mode</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| MBR   | Motor holding brake  
• 1: motor holding brake is closed  
• 0: motor holding brake is released  
**Note:** MBR is only status signal because the control and the power supply of the motor holding brake is realized with separate terminals.                                                                                           | ✓            | ✓            |
| OLL   | Overload level reached  
• 1: motor has reached the parameterizable output overload level (p29080 in % of rated torque, default: 100%, max: 300%)  
• 0: motor has not reached the overload level                                                                                                                                                                              | ✓            | ✓            |
| RDY_ON| Ready for servo on  
• 1: ready to servo on  
• 0: drive is not ready for servo on (fault occurs, main power supply is missing, or STW1.1 and STW1.2 are not set to 1)  
**Note:** After the drive is servo on, the signal remains in 1 status unless the above abnormal cases happen.                                                                                                           | ✓            | ✓            |
| INP   | In-position signal  
• 1: number of droop pulses is in the preset in-position range (parameter p2544)  
• 0: droop pulses are beyond the in-position range                                                                                                                                                                         | X            | ✓            |
| REFOK | Referenced  
• 1: referenced  
• 0: not referenced                                                                                                                                                                                                                                                             | X            | ✓            |
| STO_EP| STO active  
• 1: the enable signal is missing, indicating that STO is active.  
• 0: the enable signal is available, indicating that STO is inactive.  
**Note:** STO_EP is only a status signal for STO input terminals but not a safe DO for the Safety Integrated function.                                                                                                 | ✓            | ✓            |
Wiring

The digital outputs support both PNP and NPN types of wirings. You can find detailed information from the following diagrams:

DIs/Dos for SINAMICS V90 PTI

DIs

You can assign a maximum of 28 internal digital input signals to the SINAMICS V90 servo drive. For detailed information about these signals, see the table below:

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PTI</td>
</tr>
<tr>
<td>1</td>
<td>SON</td>
<td>Edge</td>
<td>Servo-on</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1: powers on power circuit and makes servo drive ready to operate.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1→0</td>
<td>• 1→0: motor ramps down (OFF1) in PTI, IPos, and S modes; motor coasts down (OFF2) in T mode.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RESET</td>
<td>Edge</td>
<td>Reset alarms</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1: Reset alarms</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CWL</td>
<td>Edge</td>
<td>Clockwise over-travel limit (positive limit)</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1→0</td>
<td>• 1 = condition for operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 1→0: emergency stop (OFF3)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CCWL</td>
<td>Edge</td>
<td>Counter-clockwise over-travel limit (negative limit)</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1→0</td>
<td>• 1 = condition for operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 1→0: emergency stop (OFF3)</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>G-CHANGE</td>
<td>Level</td>
<td>Gain change between the first and the second gain parameter set.</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 0: the first gain parameter set</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 1: the second gain parameter set</td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Type</td>
<td>Description</td>
<td>Control mode</td>
</tr>
<tr>
<td>-----</td>
<td>-----------------</td>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PTI</td>
</tr>
</tbody>
</table>
| 6   | P-TRG  (P-TRG in PTI mode is reserved for future use) | Level Edge 0→1 | In PTI mode: pulse allowable/inhibit.  
- 0: operation with pulse train setpoint is possible  
- 1: inhibit the pulse train setpoint  
In IPos mode: position trigger  
- 0→1: starts positioning of selected fixed position setpoint | ✓ | ✓ | X | X |
| 7   | CLR             | Level      | Clear position control droop pulses.  
- 0: not clear  
- 1: clear the droop pulses based on the selected clear mode by p29242 | ✓ | X | X | X |
| 8   | EGEAR1          | Level      | Electronic gear.  
A combination of the signals EGEAR1 and EGEAR2 can select four electronic gear ratios.  
EGEAR2 : EGEAR1  
- 0 : 0: electronic gear ratios 1  
- 0 : 1: electronic gear ratios 2  
- 1 : 0: electronic gear ratios 3  
- 1 : 1: electronic gear ratios 4 | ✓ | X | X | X |
| 9   | EGEAR2          | Level      | Torque limit selection.  
A combination of TLIM1 and TLIM2 can select four torque limit sources (one external torque limit, three internal torque limits).  
TLIM2 : TLIM1  
- 0 : 0: internal torque limit 1  
- 0 : 1: external torque limit (analog input 2)  
- 1 : 0: internal torque limit 2  
- 1 : 1: internal torque limit 3 | ✓ | X | X | X |
| 10  | TLIM1           | Level      | Enable clockwise rotations.  
- 1: Enable clockwise rotation, ramp up  
- 0: Disable clockwise rotation, ramp down | X | X | ✓ | ✓ |
| 11  | TLIM2           | Level      | Enable counter-clockwise rotations.  
- 1: Enable counter-clockwise rotation, ramp down  
- 0: Disable counter-clockwise rotation, ramp up | X | X | ✓ | ✓ |
| 12  | ZSCLAMP         | Level      | Zero speed clamps.  
- 1 = when the motor speed setpoint is an analog signal and lower than the threshold level (p29075), the motor is clamped.  
- 0 = no action | X | X | ✓ | X |
<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>SPD1</td>
<td>Level</td>
<td>Select speed mode: fixed speed setpoint.</td>
<td>PTI</td>
</tr>
<tr>
<td>16</td>
<td>SPD2</td>
<td>Level</td>
<td>A combination of the signals SPD1, SPD2 and SPD3 can select eight speed setpoint sources (one external speed setpoint, seven fixed speed setpoints).</td>
<td>X</td>
</tr>
<tr>
<td>17</td>
<td>SPD3</td>
<td>Level</td>
<td>X X X</td>
<td>✓</td>
</tr>
<tr>
<td>18</td>
<td>TSET</td>
<td>Level</td>
<td>Torque setpoint selection. This signal can select two torque setpoint sources (one external torque setpoint, one fixed torque setpoint).</td>
<td>✓</td>
</tr>
<tr>
<td>19</td>
<td>SLIM1</td>
<td>Level</td>
<td>Speed limit selection. A combination of SLIM1 to SLIM2 can select four speed limit sources (one external speed limit, three internal speed limits).</td>
<td>✓</td>
</tr>
<tr>
<td>20</td>
<td>SLIM2</td>
<td>Level</td>
<td>X X X</td>
<td>✓</td>
</tr>
<tr>
<td>21</td>
<td>POS1</td>
<td>Level</td>
<td>Select position setpoint. A combination of the signals POS1 to POS3 can select eight fixed position setpoint sources.</td>
<td>X</td>
</tr>
<tr>
<td>22</td>
<td>POS2</td>
<td>Level</td>
<td>X X X</td>
<td>✓</td>
</tr>
<tr>
<td>23</td>
<td>POS3</td>
<td>Level</td>
<td>X X X</td>
<td>✓</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Type</td>
<td>Description</td>
<td>Control mode</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PTI</td>
</tr>
<tr>
<td>24</td>
<td>REF</td>
<td>Edge</td>
<td>Set reference point with digital input or reference cam input for reference approaching mode.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1: reference input</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>SREF</td>
<td>Edge</td>
<td>The reference approach can be started with the signal SREF.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1 start reference approach</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>STEPF</td>
<td>Edge</td>
<td>Step forward to the next fixed position setpoint.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1 start step action</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>STEPB</td>
<td>Edge</td>
<td>Step backward to the previous fixed position setpoint.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1 start step action</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>STEPH</td>
<td>Edge</td>
<td>Step to the fixed position setpoint 1.</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0→1</td>
<td>• 0→1 start step action</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

When working in the torque control mode, the torque setpoint equals to 0 if CWE and CCWE are at the same status. For more information, see the direction and stop relevant section in the SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions.

**Note**

Invalid circumstances for DI signals

When SINAMICS V-ASSISTANT is communicating with the drive or you are operating the drive on SINAMICS V-ASSISTANT, some DI signals are invalid:
- During referencing via SINAMICS V-ASSISTANT, DI signal SREF is invalid.
- During a trial run test, DI signal SON is invalid; meanwhile, DI7 and DI8 are occupied by SINAMICS V-ASSISTANT.

**Direct signal map**

Force the following six signals to logical "1" with parameter p29300 (P_DI_Mat):
- SON
- CWL
- CCWL
- TLIM1
- SPD1
- TSET
- EMGS
The definition for p29300 is as follows:

<table>
<thead>
<tr>
<th>Bit 6</th>
<th>Bit 5</th>
<th>Bit 4</th>
<th>Bit 3</th>
<th>Bit 2</th>
<th>Bit 1</th>
<th>Bit 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMGS</td>
<td>TSET</td>
<td>SPD1</td>
<td>TLIM1</td>
<td>CCWL</td>
<td>CWL</td>
<td>SON</td>
</tr>
</tbody>
</table>

For example, if you set p29300 = 1 to force the signal SON to a logical high signal, DI1 can then be assigned to other desired signals.

**Note**

The parameter p29300 has higher priority than the DIs.

The bit 6 of p29300 is used for emergency stop. You are not allowed to modify it when the drive is in "S ON" state.

**Wiring**

The digital inputs support both PNP and NPN types of wirings. You can find detailed information from the following diagrams:
DOs

You can assign a maximum of 15 internal digital output signals to the SINAMICS V90 servo drive. For detailed information about these signals, see the table below:

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Descriptions</th>
<th>Control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>PTI</td>
</tr>
<tr>
<td>1</td>
<td>RDY</td>
<td>Servo ready</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: ready to operate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: drive not ready (alarm occurs or enable signal is missing)</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>FAULT</td>
<td>Fault</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: in fault status</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: no fault</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>INP</td>
<td>In-position signal</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: number of droop pulses is in the preset in-position range (parameter p2544)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: droop pulses are beyond the in-position range</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ZSP</td>
<td>Zero speed detection</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: motor speed is equal with or lower than the zero speed (can be set with parameter p2161).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: motor speed is higher than zero speed + hysteresis (10 rpm).</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>SPDR</td>
<td>Speed reached</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: motor actual speed has nearly (internal hysteresis 10 rpm) reached the speed of the internal speed command or analog speed command. The speed approaching range can be set via parameter (p29078)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: speed difference between speed setpoint and actual is larger than internal hysteresis.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>TLR</td>
<td>Torque limit reached</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: the generated torque has nearly (internal hysteresis) reached the value of the positive torque limit, negative torque limit or analog torque limit</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: the generated torque has not reached the limit</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>SPLR</td>
<td>Speed limit reached</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: the speed has nearly (internal hysteresis, 10 rpm) reached the speed limit.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: the speed has not reached the speed limit</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>MBR</td>
<td>Motor holding brake</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: motor holding brake is closed</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0: motor holding brake is released</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: MBR is only status signal because the control and the power supply of the motor holding brake is realized with separate terminals.</td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Descriptions</td>
<td>Control mode</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>9</td>
<td>OLL</td>
<td>Overload level reached  &lt;br&gt;• 1: motor has reached the parameterizable output overload level (p29080 in % of rated torque, default: 100%, max: 300%)  &lt;br&gt;• 0: motor has not reached the overload level</td>
<td>✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>10</td>
<td>WARNING1</td>
<td>Warning 1 condition reached  &lt;br&gt;• 1: parameterizable warning 1 condition has been reached.  &lt;br&gt;• 0: warning 1 condition has not been reached.  &lt;br&gt;Note: after the drive is in &quot;S ON&quot; state, the signal remains at high level (1) unless the above abnormal cases happen.</td>
<td>✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>11</td>
<td>WARNING2</td>
<td>Warning 2 condition reached  &lt;br&gt;• 1: parameterizable warning 2 condition has been reached.  &lt;br&gt;• 0: warning 2 condition has not been reached.  &lt;br&gt;Note: after the drive is in &quot;S ON&quot; state, the signal remains at high level (1) unless the above abnormal cases happen.</td>
<td>✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>12</td>
<td>REFOK</td>
<td>Referenced  &lt;br&gt;• 1 = Referenced  &lt;br&gt;• 0 = Not referenced</td>
<td>X ✓ X X</td>
</tr>
<tr>
<td>13</td>
<td>CM_STA</td>
<td>Current control mode  &lt;br&gt;• 1 = The second mode in five compound control modes (PTI/S, IPos/S, PTI/T, IPo/s/T, S/T)  &lt;br&gt;• 0 = The first mode in five compound control modes or four basic modes (PTI, IPos, S, T)</td>
<td>✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>14</td>
<td>RDY_ON</td>
<td>Ready for servo on  &lt;br&gt;• 1: ready to servo on  &lt;br&gt;• 0: drive is not ready for servo on (a fault occurs or the main power supply is missing)  &lt;br&gt;Note: after the drive is in &quot;S ON&quot; state, the signal remains at high level (1) unless the above abnormal cases happen.</td>
<td>✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>15</td>
<td>STO_EP</td>
<td>STO active  &lt;br&gt;• 1: the enable signal is missing, indicating that STO is active.  &lt;br&gt;• 0: the enable signal is available, indicating that STO is inactive.  &lt;br&gt;Note: STO_EP is only a status signal for STO input terminals but not a safe DO for the Safety Integrated function.</td>
<td>✓ ✓ ✓ ✓</td>
</tr>
</tbody>
</table>
Assigning warning signals to digital outputs

You can assign two groups of warning signals to digital outputs with parameters p29340 (first group of warning signals active) and p29341 (second group of warning signals active).

<table>
<thead>
<tr>
<th>Setting (p29340/p29341)</th>
<th>Warning conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Overload protection: load factor is 85% of or above the motor utilization.</td>
</tr>
<tr>
<td>2</td>
<td>Braking resistor: capacity of the braking resistor is 85% of or above the resistor power rating.</td>
</tr>
<tr>
<td>3</td>
<td>Fan alarm: fan has stopped for 1 second or longer.</td>
</tr>
<tr>
<td>4</td>
<td>Encoder alarm</td>
</tr>
<tr>
<td>5</td>
<td>Motor overheat: motor has reached 85% of the maximum allowed motor temperature.</td>
</tr>
<tr>
<td>6</td>
<td>Lifetime detection: the life expectancy of the capacity or the fan is shorter than the specified time.</td>
</tr>
</tbody>
</table>

If warning condition assigned to p29340 occurs, WARNING1 becomes ON.

If warning condition assigned to p29341 occurs, WARNING2 becomes ON.

Wiring

The digital outputs 1 to 3 only support the wiring of the NPN type as illustrated below:
The digital outputs 4 to 6 support the wiring of both the NPN and PNP types as illustrated below:

**NPN wiring**

**PNP wiring**

### 4.4.1.3 Analog inputs (AIs)

Two analog inputs in total are available:

- AI1: linked with speed related signals.
- AI2: linked with torque related signals.

In different control modes, the analog inputs are linked with different signals:

<table>
<thead>
<tr>
<th>Control mode</th>
<th>AI1</th>
<th>AI2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position (PTI and IPos)</td>
<td>Not used</td>
<td>Torque limitation</td>
</tr>
<tr>
<td>S</td>
<td>Speed setpoint</td>
<td>Torque limitation</td>
</tr>
<tr>
<td>T</td>
<td>Speed limitation</td>
<td>Torque setpoint</td>
</tr>
<tr>
<td>PTI/S and IPos/S</td>
<td>Not used in position control modes</td>
<td>Torque limitation</td>
</tr>
<tr>
<td></td>
<td>--&gt; Speed setpoint in S mode</td>
<td></td>
</tr>
<tr>
<td>PTI/T and IPos/T</td>
<td>Not used in position control modes</td>
<td>Torque limitation in position control modes</td>
</tr>
<tr>
<td></td>
<td>--&gt; Speed limitation in T mode</td>
<td>--&gt; Torque setpoint in T mode</td>
</tr>
<tr>
<td>S/T</td>
<td>Speed setpoint in S mode</td>
<td>Torque limitation in S mode</td>
</tr>
<tr>
<td></td>
<td>--&gt; Speed limitation in T mode</td>
<td>--&gt; Torque setpoint in T mode</td>
</tr>
</tbody>
</table>
### 4.4.1.4 Analog outputs (AOs)

Two parameters, p29350 (selects signal sources for AO1) and p29351 (selects signal sources for AO2), are used to select the source of analog output:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Source</th>
<th>Value</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>p29350</td>
<td>0 (default)</td>
<td>Actual speed (reference p29060)</td>
<td>7</td>
<td>Pulse input frequency (reference 100 k)</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Actual torque (reference 3 × r0333)</td>
<td>8</td>
<td>Pulse input frequency (reference 1000 k)</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Speed setpoint (reference p29060)</td>
<td>9</td>
<td>Remaining number of pulses (reference 1 k)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Torque setpoint (reference 3 × r0333)</td>
<td>10</td>
<td>Remaining number of pulses (reference 10 k)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>DC bus voltage (reference 1000 V)</td>
<td>11</td>
<td>Remaining number of pulses (reference 100 k)</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Pulse input frequency (reference 1 k)</td>
<td>12</td>
<td>Remaining number of pulses (reference 1000 k)</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Pulse input frequency (reference 10 k)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>p29351</td>
<td>0</td>
<td>Actual speed (reference p29060)</td>
<td>7</td>
<td>Pulse input frequency (reference 100 k)</td>
</tr>
<tr>
<td></td>
<td>1 (default)</td>
<td>Actual torque (reference 3 × r0333)</td>
<td>8</td>
<td>Pulse input frequency (reference 1000 k)</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Speed setpoint (reference p29060)</td>
<td>9</td>
<td>Remaining number of pulses (reference 1 k)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Torque setpoint (reference 3 × r0333)</td>
<td>10</td>
<td>Remaining number of pulses (reference 10 k)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>DC bus voltage (reference 1000 V)</td>
<td>11</td>
<td>Remaining number of pulses (reference 100 k)</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Pulse input frequency (reference 1 k)</td>
<td>12</td>
<td>Remaining number of pulses (reference 1000 k)</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Pulse input frequency (reference 10 k)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4.4.1.5 Pulse train inputs (PTIs)

The SINAMICS V90 servo drive supports two kinds of setpoint pulse train input forms:

- AB track pulse
- Pulse + Direction

For both forms, positive logic and negative logic are supported:

<table>
<thead>
<tr>
<th>Pulse train input form</th>
<th>Positive logic = 0</th>
<th>Negative logic = 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Forward (CW)</td>
<td>Reverse (CCW)</td>
</tr>
<tr>
<td></td>
<td>Forward (CW)</td>
<td>Reverse (CCW)</td>
</tr>
</tbody>
</table>

| AB track pulse          | A                  | A                  |
|                        | B                  | B                  |

| Pulse + Direction       | Pulse              | Pulse              |
|                        | Direction          | Direction          |

4.4.1.6 Pulse train encoder outputs (PTOs)

Function

A pulse train encoder output (PTO) which provides pulse signals can transmit the signals to the controller to realize a closed-loop control system inside the controller, or transmit them to another drive as pulse train setpoint for a synchronous axis.

4.4.2 Testing motor

Two sub-functions are available:

- Jog (Page 107)
- Position trial run (V90 PTI only) (Page 108)

4.4.2.1 Jog

For detailed information about the Jog function, see Section "Jog (Page 47)".
4.4.2.2 Position trial run (V90 PTI only)

In online mode, you can configure this function on the following panel:

Note
Position trial run is only available in PTI and IPos control modes.

Operating sequence

1. Enter the Jog speed.
2. Use this button to enable the Jog function.
   
   Note
   After clicking this button, a warning message appears. Click OK in the message window to confirm executing servo-on.

3. Click this button to rotate the motor clockwise and set a proper limit position.
4. Obtain the current position by clicking this button.
5. Click this button to rotate the motor counter-clockwise and set a proper limit position.

6. Obtain the current position by clicking this button.
   Note: Make sure the actual position is within the scope. Otherwise, the position trial run cannot be started.

7. Use this button to disable the Jog function.
   Note: The Jog function must be disabled before position trial run is started.

8. Enter the moving distance and moving speed.

9. Click this button to enable the trial run function.

10. Start trial run by clicking this button. Or otherwise, click the following button to stop trial run:

11. If necessary, click this button to move back to the previous position.

4.4.3 Optimizing drive

You can select the desired tuning mode with the tabs on the following panel:

- **One-button auto tuning**
- **Real-time auto tuning**

**Auto-tuning modes**

SINAMICS V90 PN supplies two auto-tuning modes: one-button auto tuning and real-time auto tuning. The auto tuning function can optimize control parameters with ratio of machine load moment of inertia (p29022) and set suitable current filter parameters to suppress the machine resonance automatically. You can change the dynamic performance of the system by setting different dynamic factors.

- **One-button auto tuning**
  - One-button auto tuning estimates the machine load moment of inertia and mechanical characteristics with internal motion commands. To achieve the desired performance, you can execute the process many times before you control the drive with the host controller. The maximum speed is limited by the rated speed.

- **Real-time auto tuning**
  - Real-time auto tuning estimates the machine load moment of inertia automatically while the drive is running with the host controller command. After enabling the servo on (SON), the real-time auto tuning function stays effective for the servo drive. If you do not need to estimate the load moment of inertia continuously, you can disable the function when the system performance is acceptable.
4.4.3.1 One-button auto tuning

**Note**
Before using the one-button auto tuning, move the servo motor to the middle of mechanical position to avoid approaching the actual machine position limit.

With one-button auto tuning, the servo drive can automatically estimate the ratio of load moment of inertia.

**Prerequisites for one-button auto tuning**
- The ratio of machine load moment of inertia is unknown and needs to be estimated.
- The motor is allowed to rotate clockwise and counter clockwise.
- The motor rotation position (p29027 defines that one revolution equals to 360 degree) is allowed by the machine.
  - For the motor with an absolute encoder: position limitation is defined by p29027
  - For the motor with an incremental encoder: the motor must be allowed to rotate freely about two rounds when tuning starts

**Implement the following steps to use the one-button auto tuning function:**

1. Select the dynamic factor in the following area:

   ![Dynamic factors](image)

   For more information about selecting the dynamic factor, see the SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions.

2. Configure the test signal in the following area:

   ![Test signal configuration](image)

   **Note:**
   The recommended position amplitude (p29027) is 360°.

3. Click the following button to configure the parameters for the one-button auto tuning function.

   ![Advanced settings](image)
4. Set the parameters in the window below:

![Advanced settings window](image)

**Note:**
You can set the ratio of machine load moment of inertia (p29022) with the following methods:

- Enter it manually if you have known the ratio of machine load moment of inertia
- Estimate the ratio of machine load moment of inertia with one-button auto tuning (p29023.2 = 1). When you have executed the one-button tuning many times and obtained a stable value of p29022, you can stop estimating it by setting p29023.2 = 0.

Parameter p29028 is available when the multi-axis interpolation function is activated (p29023.7 = 1). If the axes are used as the interpolation axes, you need to set the same pre-control time constants (p29028) for them.

The parameters in advanced settings window must be set carefully when the auto-tuning function is disabled (p29021 = 0).

5. Click the following button to enable the function after the parameters are set.

![Enable one button auto tuning](image)

6. Click this button to start tuning.

![Servo on](image)
7. After the tuning is completed, the tuning results window appears. 

![Tuning Results Window]

Click the **Accept** button to apply the tuning result; otherwise, click the **Abort** button to abort the tuning result.

8. Copy the tuned parameters from RAM to ROM to save them when the tuning is completed and the drive performance is acceptable.

**Note**

After servo on, the motor runs with the test signal.

When the one-button auto tuning process is completed successfully, the parameter p29021 is set to 0 automatically. You can also set the parameter p29021 to 0 before servo on to interrupt the one-button auto tuning. Before you save the parameters on the drive, make sure that p29021 has been changed to 0.

**Note**

Do not use the JOG function when the one-button tuning function is in use.

**Note**

After the one-button tuning function is activated, no operation is allowed except servo off and emergency stop.

**Note**

After activating one-button auto tuning, do not change other auto tuning related control/filter parameters since these parameters can be set automatically and your changes can not be accepted.

**Note**

One-button auto tuning can cause some changes of the control parameters. When the system rigidity is low, this may lead to a situation that when you set EMGS = 0, the motor needs take a long time to realize emergency stop.
Resonance suppression with one-button auto tuning (p29021=1, p29023.1=1)

The resonance suppression function is used together with the one-button auto tuning function. The function is activated by default.

The function can be activated/deactivated with bit 1 of p29023.

Before you use the resonance suppression function with one-button auto tuning, make sure the load is mounted as required and the servo motor can rotate freely. When the one-button auto tuning process completes successfully, the servo drive automatically sets the following notch filter relevant parameters with actual machine characteristic. Four current setpoint filters can be activated at most. You can check the following parameters in the tuning result window.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value range</th>
<th>Default value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>p1663</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 2 denominator.</td>
</tr>
<tr>
<td>p1664</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 2 denominator.</td>
</tr>
<tr>
<td>p1665</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 2 numerator.</td>
</tr>
<tr>
<td>p1666</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 2 numerator.</td>
</tr>
<tr>
<td>p1668</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 3 denominator.</td>
</tr>
<tr>
<td>p1669</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 3 denominator.</td>
</tr>
<tr>
<td>p1670</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 3 numerator.</td>
</tr>
<tr>
<td>p1671</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 3 numerator.</td>
</tr>
<tr>
<td>p1673</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 4 denominator.</td>
</tr>
<tr>
<td>p1674</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 4 denominator.</td>
</tr>
<tr>
<td>p1675</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 4 numerator.</td>
</tr>
<tr>
<td>p1676</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 4 numerator.</td>
</tr>
</tbody>
</table>

**Note**

Notch filter remains active when the resonance suppression function is activated automatically.

After one-button tuning, four filters can be activated at most. You can deactivate the notch filters by setting the parameter p1656.
4.4.3.2 Real-time auto tuning

Note
Under operating conditions that impose sudden disturbance torque during acceleration/deceleration or on a machine that its rigidity is poor, auto tuning may not function properly, either. In such cases, use one-button auto tuning or manual tuning to optimize the drive.

With real-time auto tuning, the servo drive can automatically estimate the ratio of load moment of inertia and set the optimum control parameters.

Prerequisites for real-time auto tuning
- The drive must be controlled by the host controller.
- The machine actual load moment of inertia is different when the machine moves to the different positions.
- Make sure that the motor has multiple accelerations and decelerations. Step command is recommended.
- Machine resonance frequency changes when the machine is running.

Implement the following steps to use the real-time auto tuning function:

1. Select the dynamic factor in the following area:

   For more information about selecting the dynamic factor, see the SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions.

2. Click the following button to configure the parameters for the real-time auto tuning function.
3. Set the parameters in the window below:

![Advanced settings window]

**Note:**
You can set the ratio of machine load moment of inertia (p29022) with the following methods:

- Enter it manually if you have known the ratio of machine load moment of inertia
- Use the ratio of machine load moment of inertia estimated by the one-button auto tuning function directly
- Estimate the ratio of machine load moment of inertia with real-time auto tuning (p29024.2 = 1). When you have obtained a stable value of p29022, you can stop estimating it by setting p29024.2 = 0.

Parameter p29028 is available when the multi-axis interpolation function is activated (p29024.7 = 1). If the axes are used as the interpolation axes, you need to set the same pre-control time constants (p29028) for them.

The parameters in advanced settings window must be set carefully when the auto-tuning function is disabled (p29021 = 0).

4. Click the following button to start tuning after the parameters are set.

![Enable real time auto tuning button]
5. Perform the servo on for the drive with host controller and tuning starts. For example, you can use the following method to run the motor. Implement servo on for the drive with Jog.

Enter the speed for the motor and press the direction button to let the motor run.

6. To achieve the desired system performance, you can change the dynamic factors or related configuration parameters during tuning.

7. If the drive performance is acceptable, disable the tuning function by servo off and set p29021 = 0.

8. Copy the tuned parameters from RAM to ROM to save them.

Resonance suppression with real-time auto tuning (p29021=3, p29024.6=1)

The resonance suppression function is used together with the real-time auto tuning function. The function is activated by default.

When you use real-time auto tuning function, you are recommended to disable the resonance suppression function to get a high dynamic performance if there is no resonance in the machine.

The function can be activated/deactivated with the bit 6 of p29024.

When you choose to use the resonance suppression function with real-time auto tuning, the servo drive performs real-time detection of the resonance frequency and configures the following notch filter relevant parameters accordingly:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value range</th>
<th>Default value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>p1663</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 2 denominator.</td>
</tr>
<tr>
<td>p1664</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 2 denominator.</td>
</tr>
<tr>
<td>p1665</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 2 numerator.</td>
</tr>
<tr>
<td>p1666</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 2 numerator.</td>
</tr>
</tbody>
</table>
4.4.3.3 Manual tuning

When the auto tuning function cannot reach the expected tuning results, you can disable the auto tuning function by setting the parameter p29021 and manually perform tuning:

- p29021=5: auto tuning function is disabled and all control parameters are reset to tuning default values.
- p29021=0: auto tuning function is disabled without changing control parameters.

Parameter settings

You can set the parameters on the following panel:

<table>
<thead>
<tr>
<th>Group</th>
<th>Parameter number</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
<th>Range</th>
<th>Factory setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>p29022</td>
<td>Tuning Ratio of Total Time</td>
<td>1.000</td>
<td>N/A</td>
<td>0.100</td>
<td>1</td>
</tr>
<tr>
<td>Basic</td>
<td>p29025</td>
<td>Tuning Configuration coef. 4</td>
<td>4.000</td>
<td>N/A</td>
<td>NULL</td>
<td>4</td>
</tr>
<tr>
<td>Gain adjust</td>
<td>p29110[0]</td>
<td>Position Loop Gain Proport.</td>
<td>1.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Gain adjust</td>
<td>p29111</td>
<td>Speed Pre-control Factor</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Gain adjust</td>
<td>p29112[0]</td>
<td>Speed Loop Gain Speed</td>
<td>0.300</td>
<td>0.300</td>
<td>0.300</td>
<td>0</td>
</tr>
<tr>
<td>Gain adjust</td>
<td>p29113[0]</td>
<td>Speed Loop Integral Time</td>
<td>15.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Position control</td>
<td>p2330</td>
<td>LR position setpoint filter 1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Position control</td>
<td>p2372</td>
<td>EPOS maximum acceleration</td>
<td>100.000</td>
<td>100.000</td>
<td>100.000</td>
<td>100.000</td>
</tr>
<tr>
<td>Position control</td>
<td>p2373</td>
<td>EPOS maximum deceleration</td>
<td>100.000</td>
<td>100.000</td>
<td>100.000</td>
<td>100.000</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1414</td>
<td>Speed setpoint filter 1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1415</td>
<td>Speed setpoint filter 1 type</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1416</td>
<td>Speed setpoint filter 1 de</td>
<td>1000.000</td>
<td>1000.000</td>
<td>1000.000</td>
<td>1000.000</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1417</td>
<td>Speed setpoint filter 1 de</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1418</td>
<td>Speed setpoint filter 1 de</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1419</td>
<td>Speed setpoint filter 1 de</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1420</td>
<td>Speed setpoint filter 1 de</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
<tr>
<td>Speed filter setting</td>
<td>p1441</td>
<td>Actual speed smoothing</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0</td>
</tr>
</tbody>
</table>

Click **Reset to default** to reset the following parameters to their tuning defaults. The tuning default values of the parameters are different when you use the different drives and motors. The function of the button is not drive default so the tuning default values of the control parameters are different with their factory settings.

- p1414
- p1415
- p1656
- p1658
- p1659
- p2533
- p29110[0]
Resonance suppression with manual tuning (p29021=0)

When both the resonance suppression with real-time auto tuning and one-button tuning mode cannot reach the suppression effect, you can do the resonance suppression by manually setting the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value range</th>
<th>Default value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>p1663</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 2 denominator.</td>
</tr>
<tr>
<td>p1664</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 2 denominator.</td>
</tr>
<tr>
<td>p1665</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 2 numerator.</td>
</tr>
<tr>
<td>p1666</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 2 numerator.</td>
</tr>
<tr>
<td>p1668</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 3 denominator.</td>
</tr>
<tr>
<td>p1669</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 3 denominator.</td>
</tr>
<tr>
<td>p1670</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 3 numerator.</td>
</tr>
<tr>
<td>p1671</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 3 numerator.</td>
</tr>
<tr>
<td>p1673</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 4 denominator.</td>
</tr>
<tr>
<td>p1674</td>
<td>0.001 to 10</td>
<td>0.3</td>
<td>-</td>
<td>Damp of current notch filter 4 denominator.</td>
</tr>
<tr>
<td>p1675</td>
<td>0.5 to 16000</td>
<td>1000</td>
<td>Hz</td>
<td>Natural frequency of current notch filter 4 numerator.</td>
</tr>
<tr>
<td>p1676</td>
<td>0.0 to 10</td>
<td>0.01</td>
<td>-</td>
<td>Damp of current notch filter 4 numerator.</td>
</tr>
</tbody>
</table>

Assume the notch frequency is $f_{sp}$, notch width is $f_{BB}$, and notch depth is $K$, then the filter parameters can be calculated as follows:

$p1663 = p1665 = f_{sp}$

$p1664 = f_{BB} / (2 \times f_{sp})$

$p1666 = (f_{BB} \times 10^{k/20}) / (2 \times f_{sp})$
Switching modes

The following two switching modes are only available for V90 PTI:

- **Gain switching**
  
  Parameters set 1: p291[0][0], p291[20][0], p291[24][0]

  Parameters set 2: p291[0][1], p291[20][1], p291[24][1]

  Switching mode: Disabled

  Smoothing time during gain switching: 1.000 ms

- **Speed loop PI/P switching**
  
  Switching mode: Torque is higher than threshold value

  Conditional threshold: 100.000 %

These two switching modes cannot be used at the same time. Once one mode is enabled, the other one becomes disabled. The functions of auto-tuning and gain switching must be disabled so that the function of PI/P switching can be available. When the gain switching function is enabled, the PI/P switching function is disabled and the settings can not be cleared.

- **Gain switching**
  
  Five gain switching modes in total are available:
  - Gain switching disabled
  - Gain switching using digital input signal (G-CHANGE)
  - Gain switching using position deviation
  - Gain switching using position setpoint frequency
  - Gain switching using actual speed

  If you select either of the last three gain switching modes, you need to set the conditional threshold.
- **Speed loop PI/P switching**

  Five switching modes in total are available for PI/P switching:
  - using torque setpoint
  - using an external digital input signal (G-CHANGE)
  - using speed setpoint
  - using acceleration setpoint
  - using pulse deviation

  If you select either of the PI/P switching modes (except the second mode), you need to set the conditional threshold as shown in the above screenshot.

**Note**

**PI/P switching**

This function is **not** available in T mode and responds with a delay of several milliseconds.

### 4.4.3.4 Low frequency vibration suppression

Low frequency vibration suppression is a position setpoint filter function. It can suppress the vibration frequency within 0.5 Hz to 62.5 Hz.

This function is only available in IPos and EPOS control modes.

**Parameter settings**

To use the vibration suppression function, you need to configure the following parameters accordingly:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value range</th>
<th>Default value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
</table>
| p29035     | 0 to 1      | 0             | -    | Vibration suppression activation  
  
  = 0: disable  
  
  = 1: enable  |
| p31581     | 0 to 1      | 0             | -    | Vibration suppression filter type  
  
  = 0: rugged  
  
  = 1: sensitive  |
| p31585     | 0.5 to 62.5 | 1             | Hz   | Vibration suppression filter frequency  |
| p31586     | 0 to 0.99   | 0.03          | -    | Vibration suppression filter damping  |
Operating sequence

1. Set the drive to servo off status.
2. Set relevant parameters on the "Viewing all parameters (Page 87)" panel.
   - Select the filter type by setting p31581:
     - p31581 = 0: rugged
     - p31581 = 1: sensitive
   - Define the suppression frequency by setting p31585 (value range: 0.5 Hz to 62.5 Hz).
   - Set the filter damping by p31586 (value range: 0 to 0.99).
3. Select the desired control mode for the drive on the following panel.
4. Enable the vibration suppression function by setting p29035 = 1 on the "Viewing all parameters (Page 87)" panel.
5. Set the drive to servo on status.
4.5 Diagnostics

4.5.1 Monitoring status

**Note**
This function can only work in online mode.

You can monitor the real-time value of motion relevant parameters. The motion data and product information are displayed on the following panel:

![Motion data table]

**Note**
The above screenshot takes the user interface of SINAMICS V-ASSISTANT for V90 PN for example.
4.5.2 Tracing signals

With this function, you can trace the performance of the connected drive in the current control mode on the following panel:

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>① Trace configuration</td>
<td></td>
<td>Opens the window of trace configuration For more information, see Section &quot;Trace configuration (Page 126)&quot;.</td>
</tr>
<tr>
<td></td>
<td>Start/stop trace (Only available in online mode)</td>
<td>Starts recording the current trace If you desire to stop the trace process, click the following button:</td>
</tr>
<tr>
<td>② Cursors</td>
<td></td>
<td>Changes the cursor shape from cross to arrow When the cursor appears as an arrow, you can directly select a curve and use it for variable calculation. <strong>Note:</strong> The selected curve is displayed highlighted. If you click this button, you can move the selected curve freely after the cursor appears in the shape of a hand.</td>
</tr>
<tr>
<td>Area</td>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Auxiliary lines | ![Vertical cursor](https://example.com/vertical-cursor.png) | Vertical cursor:  
• In the time domain chart, you can click this button to display coordinates t1 and t2 in the chart. You can move t1 or t2 when the cursor changes to ![Vertical cursor](https://example.com/vertical-cursor.png).  
• In frequency domain chart, activate this button to display a highlighted coordinate in the chart. You can move this coordinate in the chart when the cursor changes to ![Vertical cursor](https://example.com/vertical-cursor.png). |
|            | ![Horizontal cursor](https://example.com/horizontal-cursor.png) | Horizontal cursor:  
• In the time domain chart, you can click this button to display coordinates y1 and y2 in the chart. You can move y1 or y2 when the cursor changes to ![Horizontal cursor](https://example.com/horizontal-cursor.png).  
• In the frequency domain chart, the button is unavailable. |
| Zoom      | ![Zoom in](https://example.com/zoom-in.png) | Zooms in the current curves with a specified scale |
|           | ![Zoom out](https://example.com/zoom-out.png) | Zooms out the current curves with a specified scale |
|           | ![Restore](https://example.com/restore.png) | Restores curves in the chart |
| File operation | ![Open file](https://example.com/open-file.png) | Opens an existing .trc file for curve display in the chart |
|           | ![Save file](https://example.com/save-file.png) | Saves the current recording of values in the following file formats:  
• .trc: trace curve files  
• .png: bode diagrams, time domain charts or frequency domain charts |
| Reset scaling | ![Reset scaling](https://example.com/reset-scaling.png) | Displays the selected curves with the same scale, that is, the biggest scale of all selected curves |

**Note:**  
In the frequency domain chart, horizontal cursor button ![Horizontal cursor](https://example.com/horizontal-cursor.png) is unavailable.

<table>
<thead>
<tr>
<th>③ Charts</th>
<th><img src="https://example.com/charts.png" alt="Charts" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Time domain chart</td>
<td><img src="https://example.com/time-domain-chart.png" alt="Time domain chart" /></td>
</tr>
</tbody>
</table>
| T          | ![Coordinate T](https://example.com/coordinate-t.png) | Coordinate T (time):  
• t1: real-time value of coordinate t1  
• t2: real-time value of coordinate t2  
• dt: automatically calculated duration.  
Formula: \( dt = t2 - t1 \) |
<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Y    | Coordinate Y: | y1: real-time value of coordinate y1  
y2: real-time value of coordinate y2  
dy: automatically calculated value range  
Formula: $dy = y_2 - y_1$ |
| Y(T) | Coordinate Y(T): | y(t1): real-time value at the cross point of coordinate t1 and selected curve  
y(t2): real-time value at the cross point of coordinate t2 and selected curve  
dy(t): automatically calculated real-time value range  
Formula: $dy(t) = y(t_2) - y(t_1)$ |

**Note:**
You can select a coordinate by clicking its designation, then the selected coordinate is displayed yellow.

## Frequency domain chart

| 5 | Curve selection | Selects a curve to display in the chart  
|   |                 | - Time domain chart:  
|   |                 | A maximum of six curves can be simultaneously displayed in the chart.  
|   |                 | - Frequency domain chart:  
|   |                 | Only one curve can be selected to appear in the chart. |

| Frequency | Displays real-time frequency value of the horizontal cursor coordinate in the chart |
| Amplitude | Displays real-time amplitude value at the cross point of the horizontal cursor coordinate and curve |
4.5.2.1 Trace configuration

Click the following button to select the analog signal.

Select a trace signal and click **OK** to confirm your selection; or otherwise, you can click **Cancel** to abort your selection.

Click the color bar to define the display color of the curve for the signal.

Click the following button to select the digital signal.

Select a trace signal and click **OK** to confirm your selection; or otherwise, you can click **Cancel** to abort your selection.

Click the color bar to define the display color of the curve for the signal.
4.5.3 Measuring machine

The measuring function is used for controller optimization. With measuring function, you can directly inhibit the influence of higher-level control loops by means of simple parameterization, and analyze the dynamic response of individual drives.

For easier handling of the controller optimization, predefined measuring functions are available for selection. The operating mode is automatically set depending on the measuring function.

- Speed controller setpoint frequency response(before speed setpoint filter)
  The speed control loop is closed while all of the higher-level control loops are open. For the setpoint frequency response on the speed controller, the speed setpoint is activated by a PRBS signal. The evaluation of the signals is performed in the frequency range.

- Speed control system(excitation after current setpoint filter)
  The speed control loop is closed while all of the higher-level control loops are open. For the measurement of the speed controller system on the speed controller, the speed
setpoint is activated by a PRBS signal. The evaluation of the signals is performed in the frequency range.

- Current controller setpoint frequency response (after current setpoint filter)

For the reference frequency response on the current controller, the current setpoint is activated by a PRBS signal. The evaluation of the signals is performed in the frequency range.

**Note**

Measuring machine is only available in online mode.

**Overview**

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| ①   | Measuring functions | - Speed controller setpoint frequency response (before speed setpoint filter)  
- Speed control system (excitation after current setpoint filter)  
- Current controller setpoint frequency response (after current setpoint filter)  
Amplitude | The value of the signal amplitude to be applied  
For the current controller, the specification is a relative value in percent. The value refers to the reference current (p2002). For the speed controller, the amplitude specification is always in physical units. |
<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Offset</td>
<td>DC component which is superimposed on the test signal The value is normalized in the same way as the amplitude specification. Please note that the offset is subtracted again when the measured values are saved during runtime.</td>
</tr>
<tr>
<td></td>
<td>Bandwidth</td>
<td>Bandwidth of the measurement activated by a PRBS signal Bandwidth = 1/(2*sample frequency). As only multiply of $2^n$ for the minimum sampling time (0.25ms) is available, the bandwidths that can be implemented are quantized.</td>
</tr>
<tr>
<td>🔄</td>
<td>Servo on/off</td>
<td>Click and the following warning appears: Confirm by clicking to obtain the control priority for the connected drive. Then becomes If you desire to give up the control priority, you can directly click it.</td>
</tr>
<tr>
<td></td>
<td>Start trace</td>
<td>Click this button to start trace. <strong>Note:</strong> During the trace process, you cannot stop it but only wait until it is completed.</td>
</tr>
<tr>
<td>🔄</td>
<td>Cursor</td>
<td>Changes the cursor shape from cross to arrow When the cursor appears as an arrow, you can directly select a curve and use it for variable calculation. <strong>Note:</strong> The selected curve is displayed highlighted. If you click this button, you can move the selected curve freely after the cursor appears in the shape of a hand.</td>
</tr>
<tr>
<td></td>
<td>Auxiliary line</td>
<td>Vertical cursor: In the time domain chart, you can click this button to display coordinates t1 and t2 in the chart. You can move t1 or t2 when the cursor changes to In the frequency domain chart, activate this button to display a highlighted coordinate in the chart. You can move this coordinate in the chart when the cursor changes to Horizontal cursor: • In the time domain chart, you can click this button to display coordinates y1 and y2 in the chart. You can move y1 or y2 when the cursor changes to • In the frequency domain chart, the button is not available.</td>
</tr>
</tbody>
</table>
### Table: Area, Item, Description

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom</strong></td>
<td></td>
<td>Z<strong>ooms in the current curves with a specified scale</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Z<strong>ooms out the current curves with a specified scale</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>R<strong>estores curves in the chart</strong></td>
</tr>
<tr>
<td><strong>File operation</strong></td>
<td></td>
<td>O<strong>pens an existing .trc file for curve display in the chart</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>S<strong>aves the current recording of values in the following file formats:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• .trc: trace curve files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• .png: time domain charts or frequency domain charts</td>
</tr>
<tr>
<td><strong>Reset scaling</strong></td>
<td></td>
<td>D<strong>isplays the selected curves with the same scale, that is, the biggest scale of all selected curves</strong></td>
</tr>
</tbody>
</table>

**Note:**
In frequency domain chart, horizontal cursor button is unavailable.

#### 4 Chart
- **Time domain chart:**
  - Displays the time chart in curves and records measured values of parameters
- **Frequency domain chart:**
  - Available for mathematically computed curves and displays the Fourier transformation
- **Bode diagram:**
  - Available for mathematically computed curves

#### 5 Time domain chart
- **T**
  - Coordinate T (time):
    - t1: Real-time value of coordinate t1
    - t2: Real-time value of coordinate t2
    - dt: Automatically calculated duration
    - Formula: \( dt = t2 - t1 \)
- **Y**
  - Coordinate Y:
    - y1: Real-time value of coordinate y1
    - y2: Real-time value of coordinate y2
    - dy: Automatically calculated value range
    - Formula: \( dy = y2 - y1 \)
- **Y(T)**
  - y(t1): real-time value at the cross point of coordinate t1 and selected curve
  - y(t2): real-time value at the cross point of coordinate t2 and selected curve
  - dy(t): automatically calculated real-time value range
  - Formula: \( dy(t) = y(t2) - y(t1) \)

**Note:**
You can select a coordinate by clicking its designation, then the selected coordinate is displayed yellow.
<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency domain chart</td>
<td>Frequency</td>
<td>Displays real-time frequency value of the horizontal cursor coordinate in the chart</td>
</tr>
<tr>
<td></td>
<td>Amplitude</td>
<td>Displays real-time amplitude value at the cross point of the horizontal cursor coordinate and curve</td>
</tr>
<tr>
<td>Bode diagram</td>
<td>Frequency</td>
<td>Displays real-time frequency value of the horizontal cursor coordinate in the diagram</td>
</tr>
<tr>
<td></td>
<td>Amplitude</td>
<td>Displays real-time amplitude value at the cross point of the horizontal cursor coordinate and curve</td>
</tr>
<tr>
<td>⑥ Curve selection</td>
<td>Selects a curve to display in the chart.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Time domain chart:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A maximum of six curves can be simultaneously displayed in the chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Frequency domain chart:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only one curve can be selected to appear in the chart.</td>
</tr>
</tbody>
</table>
4.6 Communicating with the PLC (V90 PTI only)

The SINAMICS V90 supports communication with the PLC on the RS485 interface. You can parameterize whether the RS485 interface applies USS or Modbus RTU protocol. USS is the default bus setting. A shielded twisted pair cable is recommended for RS485 communication.

4.6.1 USS communication

The SINAMICS V90 can communicate with the PLC through an RS485 cable with the standard USS communication protocol. After the communication is established, you can change the position setpoint and speed setpoint through the USS communication protocol. The servo drive can also transmit the actual speed, torque, and alarm to the PLC through the USS communication protocol.

Telegram format

The telegram format is shown as follows:

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>PWE</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>STX: start of text</td>
<td>LGE: length</td>
<td>ADR: slave address</td>
<td>PKE: parameter ID</td>
<td>IND: sub-index</td>
<td>PWE: parameter value</td>
<td>PWE: parameter value</td>
<td>BCC: block check character</td>
</tr>
</tbody>
</table>

Relevant parameters

You can access the following parameters by USS.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>p1001</td>
<td>Fixed speed setpoint 1</td>
<td>r0020</td>
<td>Speed setpoint smoothed</td>
</tr>
<tr>
<td>p1002</td>
<td>Fixed speed setpoint 2</td>
<td>r0021</td>
<td>Actual speed smoothed</td>
</tr>
<tr>
<td>p1003</td>
<td>Fixed speed setpoint 3</td>
<td>r0026</td>
<td>DC link voltage smoothed</td>
</tr>
<tr>
<td>p1004</td>
<td>Fixed speed setpoint 4</td>
<td>r0027</td>
<td>Absolute actual current smoothed</td>
</tr>
<tr>
<td>p1005</td>
<td>Fixed speed setpoint 5</td>
<td>r0031</td>
<td>Actual torque smoothed</td>
</tr>
<tr>
<td>p1006</td>
<td>Fixed speed setpoint 6</td>
<td>r0032</td>
<td>Active power actual value smoothed</td>
</tr>
<tr>
<td>p1007</td>
<td>Fixed speed setpoint 7</td>
<td>r0034</td>
<td>Motor utilization thermal</td>
</tr>
<tr>
<td>p2617[0...7]</td>
<td>Fixed position setpoint</td>
<td>r0807</td>
<td>Master control active</td>
</tr>
<tr>
<td>p2618[0...7]</td>
<td>Speed of fixed position setpoint</td>
<td>r2521</td>
<td>LR position actual value</td>
</tr>
<tr>
<td>p2572</td>
<td>IPos maximum acceleration</td>
<td>r2556</td>
<td>LR position setpoint after setpoint smoothing</td>
</tr>
<tr>
<td>p2573</td>
<td>IPos maximum deceleration</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note
There is no priority when BOP, V-ASSISTANT, and USS access the same parameter at the same time, the value of the parameter depends on the last access operation.

Operating steps

1. Set the drive to servo off status.
2. Go to "View all parameters" panel and set the related parameters.
   - Configure the RS485 bus address by parameter p29004.
     - You can configure the slave address from 1 to 31.
   - Set the communication protocol by parameter p29007.
     - Set p29007 = 1 to use the USS protocol.
   - Set the transmission baud rate by parameter p29009.
3. Set control mode for the drive on the following panel.
4. Save the parameters and restart the drive.
5. Access the parameters via USS.
   - For IPos control mode, you can change the following parameters via USS:
     - p2617[0...7], p2618[0...7], p2572, p2573
   - For S control mode, you can change the following parameters via USS:
     - p1001 to p1007
   - Ten monitor parameters can be read by USS:
     - r0020, r0021, r0026, r0027, r0031, r0032, r0034, r0807, r2556, and r2521

Note
The USS protocol communication libraries of S7-200, S7-200 SMART V1.0, and S7-1200 do not support the communication with the SINAMICS V90 servo drive.
4.6.2 Modbus communication

The SINAMICS V90 servo drive can communicate with the PLC through an RS485 cable with the standard Modbus communication protocol. There are two ways of sending a message to a slave. One is unicast mode (addresses 1 to 31), where the master addresses the slave directly; the other is broadcast mode (address 0), where the master addresses all slaves. The broadcast mode cannot be used for an error request since all slaves cannot respond at once.

For the Modbus data format, V90 supports Modbus RTU while Modbus ASCII is not supported. Registers of the servo drive can be read by Modbus function code FC3 and written via Modbus function code FC6 (single register) or FC16 (multiple registers).

Supported function codes

The SINAMICS V90 supports only three function codes. If a request with an unknown function code is received, an error message is returned.

**FC3 - Read holding registers**

When a message with FC = 0x03 is received, then four bytes of data are expected, that is, FC3 has four bytes of data:
- Two bytes for the starting address
- Two bytes for the number of registers

<table>
<thead>
<tr>
<th>Byte 1</th>
<th>Byte 2</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Byte 7</th>
<th>Byte 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>FC (0x03)</td>
<td>Start address</td>
<td>Number of registers</td>
<td>CRC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**FC6 - Write single register**

When a message with FC = 0x06 is received, then four bytes of data are expected, that is, FC6 has four bytes of data:
- Two bytes for the register address
- Two bytes for the register value

<table>
<thead>
<tr>
<th>Byte 1</th>
<th>Byte 2</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Byte 7</th>
<th>Byte 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>FC (0x06)</td>
<td>Start address</td>
<td>New register value</td>
<td>CRC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**FC16 - Write multiple registers**

When a message with FC = 0x10 is received, then 5 + N bytes of data are expected, that is, FC16 has 5 + N bytes of data:
- Two bytes for the starting address
- Two bytes for the number of registers

<table>
<thead>
<tr>
<th>Byte 1</th>
<th>Byte 2</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Byte 7</th>
<th>Byte 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>FC (0x06)</td>
<td>Start address</td>
<td>New register value</td>
<td>CRC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
- One byte for the byte count
- N bytes for the register values

<table>
<thead>
<tr>
<th>Byte 1</th>
<th>Byte 2</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Byte 7</th>
<th>Byte 7 + N</th>
<th>Byte 8</th>
<th>Byte 8 + N</th>
<th>Byte 9</th>
<th>Byte 10 + N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Start address</td>
<td>Number of registers</td>
<td>Number of bytes</td>
<td>Register N value</td>
<td>CRC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Mapping table**

The SINAMICS V90 servo drive supports the following registers. "R", "W", "R/W" in the column access stand for read, write, read/write.

<table>
<thead>
<tr>
<th>Modbus register number</th>
<th>Description</th>
<th>Modbus access</th>
<th>Unit</th>
<th>Scaling factor</th>
<th>Range or On/Off text</th>
<th>Data/parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>40100</td>
<td>Control word (PTI, IPos, S, T)</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>-</td>
<td>Process data 1, receive word, PZD1</td>
</tr>
<tr>
<td>40101</td>
<td>Speed setpoint (S)</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-</td>
<td>Process data 2, receive word, PZD2</td>
</tr>
<tr>
<td>40102</td>
<td>MDI position setpoint high word (IPos)</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>Process data 3, receive word, PZD3</td>
</tr>
<tr>
<td>40103</td>
<td>MDI position setpoint low word (IPos)</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-</td>
<td>Process data 4, receive word, PZD4</td>
</tr>
<tr>
<td>40104</td>
<td>MDI speed setpoint high word (IPos)</td>
<td>R/W</td>
<td>1000 LU/min</td>
<td>1</td>
<td>1 to 40000000</td>
<td>Process data 5, receive word, PZD5</td>
</tr>
<tr>
<td>40105</td>
<td>MDI speed setpoint low word (IPos)</td>
<td>R/W</td>
<td>1000 LU/min</td>
<td>1</td>
<td>-</td>
<td>Process data 6, receive word, PZD6</td>
</tr>
<tr>
<td>40110</td>
<td>Status word (PTI, IPos, S, T)</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>-</td>
<td>Process data 1, send word, PZD1</td>
</tr>
<tr>
<td>40111</td>
<td>Actual speed (PTI, IPos, S, T)</td>
<td>R</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-</td>
<td>Process data 2, send word, PZD2</td>
</tr>
<tr>
<td>40112</td>
<td>Actual position high word (PTI, IPos)</td>
<td>R</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>Process data 3, send word, PZD3</td>
</tr>
<tr>
<td>40113</td>
<td>Actual position low word (PTI, IPos)</td>
<td>R</td>
<td>LU</td>
<td>1</td>
<td>-</td>
<td>Process data 4, send word, PZD4</td>
</tr>
<tr>
<td>40114</td>
<td>Actual speed high word (PTI, IPos)</td>
<td>R</td>
<td>1000 LU/min</td>
<td>1</td>
<td>1 to 40000000</td>
<td>Process data 5, send word, PZD5</td>
</tr>
<tr>
<td>40115</td>
<td>Actual speed low word (PTI, IPos)</td>
<td>R</td>
<td>1000 LU/min</td>
<td>1</td>
<td>-</td>
<td>Process data 6, send word, PZD6</td>
</tr>
<tr>
<td>40200</td>
<td>DO 1</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0747.0</td>
</tr>
<tr>
<td>40201</td>
<td>DO 2</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0747.1</td>
</tr>
<tr>
<td>40202</td>
<td>DO 3</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0747.2</td>
</tr>
<tr>
<td>40203</td>
<td>DO 4</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0747.3</td>
</tr>
<tr>
<td>40204</td>
<td>DO 5</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0747.4</td>
</tr>
<tr>
<td>Modbus register number</td>
<td>Description</td>
<td>Modbus access</td>
<td>Modbus access</td>
<td>Unit</td>
<td>Scaling factor</td>
<td>Range or On/Off text</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>------</td>
<td>----------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>40205</td>
<td>DO 6</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>-</td>
</tr>
<tr>
<td>40220</td>
<td>AO 1</td>
<td>R</td>
<td>%</td>
<td>100</td>
<td>-100.0 to 100.0</td>
<td>-</td>
</tr>
<tr>
<td>40221</td>
<td>AO 2</td>
<td>R</td>
<td>%</td>
<td>100</td>
<td>-100.0 to 100.0</td>
<td>-</td>
</tr>
<tr>
<td>40240</td>
<td>DI 1</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.0</td>
</tr>
<tr>
<td>40241</td>
<td>DI 2</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.1</td>
</tr>
<tr>
<td>40242</td>
<td>DI 3</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.2</td>
</tr>
<tr>
<td>40243</td>
<td>DI 4</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.3</td>
</tr>
<tr>
<td>40244</td>
<td>DI 5</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.4</td>
</tr>
<tr>
<td>40245</td>
<td>DI 6</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.5</td>
</tr>
<tr>
<td>40246</td>
<td>DI 7</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.6</td>
</tr>
<tr>
<td>40247</td>
<td>DI 8</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.7</td>
</tr>
<tr>
<td>40248</td>
<td>DI 9</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.8</td>
</tr>
<tr>
<td>40249</td>
<td>DI 10</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>r0722.9</td>
</tr>
<tr>
<td>40260</td>
<td>AI 1</td>
<td>R</td>
<td>%</td>
<td>100</td>
<td>-300.0 to 300.0</td>
<td>-</td>
</tr>
<tr>
<td>40261</td>
<td>AI 2</td>
<td>R</td>
<td>%</td>
<td>100</td>
<td>-300.0 to 300.0</td>
<td>-</td>
</tr>
<tr>
<td>40280/40281</td>
<td>Enable DI simulation (high part/low part)</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>p0795</td>
</tr>
<tr>
<td>40282/40283</td>
<td>Setpoint DI simulation (high part/low part)</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>HIGH/LOW</td>
<td>p0796</td>
</tr>
<tr>
<td>40300</td>
<td>Power stack code number</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 32767</td>
<td>-</td>
</tr>
<tr>
<td>40301</td>
<td>V90 OA version</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>e.g. 104xx for V01.04.xx</td>
<td>p29018[0]/100</td>
</tr>
<tr>
<td>40320</td>
<td>Rated power of the power unit</td>
<td>R</td>
<td>kW</td>
<td>100</td>
<td>0.00 to 327.67</td>
<td>-</td>
</tr>
<tr>
<td>40321</td>
<td>Current limit</td>
<td>R/W</td>
<td>A</td>
<td>1</td>
<td>0.0 to 400.0</td>
<td>-</td>
</tr>
<tr>
<td>40322</td>
<td>Ramp-up time</td>
<td>R/W</td>
<td>s</td>
<td>100</td>
<td>0.0 to 650.0</td>
<td>p1120</td>
</tr>
<tr>
<td>40323</td>
<td>Ramp-down time</td>
<td>R/W</td>
<td>s</td>
<td>100</td>
<td>0.0 to 650.0</td>
<td>p1121</td>
</tr>
<tr>
<td>40324</td>
<td>Reference speed</td>
<td>R</td>
<td>rpm</td>
<td>1</td>
<td>6 to 32767</td>
<td>Motor rated speed</td>
</tr>
<tr>
<td>40325</td>
<td>Control mode</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>0 to 8</td>
<td>p29003</td>
</tr>
<tr>
<td>40326</td>
<td>Reference mode</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>0 to 4</td>
<td>p29240</td>
</tr>
<tr>
<td>40340</td>
<td>Speed setpoint</td>
<td>R</td>
<td>rpm</td>
<td>1</td>
<td>-16250 to 16250</td>
<td>r0020</td>
</tr>
<tr>
<td>40341</td>
<td>Actual speed value</td>
<td>R</td>
<td>rpm</td>
<td>1</td>
<td>-16250 to 16250</td>
<td>r0021</td>
</tr>
<tr>
<td>40344</td>
<td>DC-link voltage</td>
<td>R</td>
<td>V</td>
<td>1</td>
<td>0 to 32767</td>
<td>r0026</td>
</tr>
<tr>
<td>40345</td>
<td>Actual current value</td>
<td>R</td>
<td>A</td>
<td>100</td>
<td>0 to 163.83</td>
<td>r0027</td>
</tr>
<tr>
<td>40346</td>
<td>Actual torque value</td>
<td>R</td>
<td>Nm</td>
<td>100</td>
<td>-325.00 to 325.00</td>
<td>r0031</td>
</tr>
<tr>
<td>40347</td>
<td>Actual active power</td>
<td>R</td>
<td>kW</td>
<td>100</td>
<td>0 to 327.67</td>
<td>r0032</td>
</tr>
<tr>
<td>40348</td>
<td>Energy consumption</td>
<td>R</td>
<td>kWh</td>
<td>1</td>
<td>0 to 32767</td>
<td>-</td>
</tr>
<tr>
<td>40349</td>
<td>Control priority</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>Manual/Auto</td>
<td>r0807</td>
</tr>
<tr>
<td>Modbus register number</td>
<td>Description</td>
<td>Modbus access</td>
<td>Unit</td>
<td>Scaling factor</td>
<td>Range or On/Off text</td>
<td>Data/parameter</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>----------------</td>
<td>------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>40350/40351</td>
<td>Position setpoint</td>
<td>R</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>r2556</td>
</tr>
<tr>
<td>40352/40353</td>
<td>Actual position value</td>
<td>R</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>r2521[0]</td>
</tr>
<tr>
<td>40354</td>
<td>Motor utilization</td>
<td>R</td>
<td>%</td>
<td>100</td>
<td>-320.00 to 320.00</td>
<td>r0034</td>
</tr>
<tr>
<td>40400</td>
<td>Failure number, index 0</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40401</td>
<td>Failure number, index 1</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40402</td>
<td>Failure number, index 2</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40403</td>
<td>Failure number, index 3</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40404</td>
<td>Failure number, index 4</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40405</td>
<td>Failure number, index 5</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40406</td>
<td>Failure number, index 6</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40407</td>
<td>Failure number, index 7</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40408</td>
<td>Alarm number</td>
<td>R</td>
<td>-</td>
<td>1</td>
<td>0 to 65535</td>
<td></td>
</tr>
<tr>
<td>40601</td>
<td>DS47 Control</td>
<td>R/W</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>40602</td>
<td>DS47 header</td>
<td>R/W</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>40603</td>
<td>DS47 data 1</td>
<td>R/W</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>40722</td>
<td>DS47 data 120</td>
<td>R/W</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>40800/40801</td>
<td>Fixed position setpoint 1</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[0]</td>
</tr>
<tr>
<td>40802/40803</td>
<td>Fixed position setpoint 2</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[1]</td>
</tr>
<tr>
<td>40804/40805</td>
<td>Fixed position setpoint 3</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[2]</td>
</tr>
<tr>
<td>40806/40807</td>
<td>Fixed position setpoint 4</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[3]</td>
</tr>
<tr>
<td>40808/40809</td>
<td>Fixed position setpoint 5</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[4]</td>
</tr>
<tr>
<td>40810/40811</td>
<td>Fixed position setpoint 6</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[5]</td>
</tr>
<tr>
<td>40812/40813</td>
<td>Fixed position setpoint 7</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[6]</td>
</tr>
<tr>
<td>40814/40815</td>
<td>Fixed position setpoint 8</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2617[7]</td>
</tr>
<tr>
<td>40840/40841</td>
<td>Speed of the fixed position 1</td>
<td>R/W</td>
<td>1000</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[0]</td>
</tr>
<tr>
<td>40842/40843</td>
<td>Speed of the fixed position 2</td>
<td>R/W</td>
<td>1000</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[1]</td>
</tr>
<tr>
<td>40844/40845</td>
<td>Speed of the fixed position 3</td>
<td>R/W</td>
<td>1000</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[2]</td>
</tr>
<tr>
<td>40846/40847</td>
<td>Speed of the fixed position 4</td>
<td>R/W</td>
<td>1000</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[3]</td>
</tr>
<tr>
<td>Modbus register number</td>
<td>Description</td>
<td>Modbus access</td>
<td>Unit</td>
<td>Scaling factor</td>
<td>Range or On/Off text</td>
<td>Data/parameter</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------</td>
<td>---------------</td>
<td>------------</td>
<td>----------------</td>
<td>----------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>40848/40849</td>
<td>Speed of the fixed position 5</td>
<td>R/W</td>
<td>1000 LU/min</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[4]</td>
</tr>
<tr>
<td>40850/40851</td>
<td>Speed of the fixed position 6</td>
<td>R/W</td>
<td>1000 LU/min</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[5]</td>
</tr>
<tr>
<td>40852/40853</td>
<td>Speed of the fixed position 7</td>
<td>R/W</td>
<td>1000 LU/min</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[6]</td>
</tr>
<tr>
<td>40854/40855</td>
<td>Speed of the fixed position 8</td>
<td>R/W</td>
<td>1000 LU/min</td>
<td>1</td>
<td>1 to 40000000</td>
<td>p2618[7]</td>
</tr>
<tr>
<td>40880/40881</td>
<td>IPos maximum acceleration</td>
<td>R/W</td>
<td>1000 LU/s²</td>
<td>1</td>
<td>1 to 2000000</td>
<td>p2572</td>
</tr>
<tr>
<td>40882/40883</td>
<td>IPos maximum deceleration</td>
<td>R/W</td>
<td>1000 LU/s²</td>
<td>1</td>
<td>1 to 2000000</td>
<td>p2573</td>
</tr>
<tr>
<td>40884/40885</td>
<td>IPos jerk limiting</td>
<td>R/W</td>
<td>1000 LU/s³</td>
<td>1</td>
<td>1 to 10000000</td>
<td>p2574</td>
</tr>
<tr>
<td>40886/40887</td>
<td>IPos reference point coordinate value</td>
<td>R/W</td>
<td>LU</td>
<td>1</td>
<td>-2147482648 to 2147482647</td>
<td>p2599</td>
</tr>
<tr>
<td>40900</td>
<td>Fixed speed setpoint 1</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1001</td>
</tr>
<tr>
<td>40901</td>
<td>Fixed speed setpoint 2</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1002</td>
</tr>
<tr>
<td>40902</td>
<td>Fixed speed setpoint 3</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1003</td>
</tr>
<tr>
<td>40903</td>
<td>Fixed speed setpoint 4</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1004</td>
</tr>
<tr>
<td>40904</td>
<td>Fixed speed setpoint 5</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1005</td>
</tr>
<tr>
<td>40905</td>
<td>Fixed speed setpoint 6</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1006</td>
</tr>
<tr>
<td>40906</td>
<td>Fixed speed setpoint 7</td>
<td>R/W</td>
<td>-</td>
<td>0x4000 hex = 100% × motor rated speed</td>
<td>-210000.000 to 210000.00</td>
<td>p1007</td>
</tr>
<tr>
<td>40934</td>
<td>MDI acceleration override</td>
<td>R/W</td>
<td>%</td>
<td>100</td>
<td>0.1 to 100</td>
<td>p2692</td>
</tr>
<tr>
<td>40935</td>
<td>MDI deceleration override</td>
<td>R/W</td>
<td>%</td>
<td>100</td>
<td>0.1 to 100</td>
<td>p2693</td>
</tr>
<tr>
<td>40950</td>
<td>Fixed torque setpoint</td>
<td>R/W</td>
<td>%</td>
<td>100</td>
<td>-100 to 100</td>
<td>p29043</td>
</tr>
<tr>
<td>40960/40961</td>
<td>Number of pulses per revolution</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>0 to 16777215</td>
<td>p29011</td>
</tr>
<tr>
<td>40962/40963</td>
<td>Numerator of electronic gear 0</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>1 to 10000</td>
<td>p29012[0]</td>
</tr>
<tr>
<td>40964/40965</td>
<td>Numerator of electronic gear 1</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>1 to 10000</td>
<td>p29012[1]</td>
</tr>
</tbody>
</table>
### Parameter scaling

Due to the limits of the integer data in the Modbus protocol, it is necessary to convert the drive parameters before transmitting them. This is done by scaling, so that a parameter, which has a position after decimal point, is multiplied by a factor, to get rid of the fractional part. The scaling factor is as defined in the above table.

<table>
<thead>
<tr>
<th>Modbus register number</th>
<th>Description</th>
<th>Modbus access</th>
<th>Unit</th>
<th>Scaling factor</th>
<th>Range or On/Off text</th>
<th>Data/parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>40966/40967</td>
<td>Numerator of electronic gear 2</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>1 to 10000</td>
<td>p29012[2]</td>
</tr>
<tr>
<td>40968/40969</td>
<td>Numerator of electronic gear 3</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>1 to 10000</td>
<td>p29012[3]</td>
</tr>
<tr>
<td>40970/40971</td>
<td>Denominator of the electronic gear</td>
<td>R/W</td>
<td>-</td>
<td>1</td>
<td>1 to 10000</td>
<td>p29013</td>
</tr>
</tbody>
</table>

#### 4.6.2.1 Cyclic communication

**Operating steps**

1. Set the drive to servo off status.
2. Go to "View all parameters" panel and set the related parameters.
   - Configure the RS485 bus address by parameter p29004.
     - You can configure the slaves address from 1 to 31.
   - Set the communication protocol by parameter p29007.
     - Set p29007 = 2 to use the Modbus protocol.
   - Select the Modbus control source by parameter p29008.
     - p29008 = 1: Setpoint and control word from Modbus PZD
     - p29008 = 2: No control word.
   - Set the transmission baud rate by parameter p29009.
   - Set the monitor time for Modbus by parameter p29019.
     Sets the monitoring time to monitor the process data received via the RS485 interface. If no process data is received within this time, then F1910 is output.
     The default value of p29019 is 0. If p29019 = 0, monitoring is deactivated.
3. Select the control mode for the drive on the following panel:

![Control Mode](image)

4. Save the parameters and restart the drive.
5. Configure the PLC parameters.
   **Note:**
   Keep the PLC baud rate the same as the drive setting.
   Set even parity check for the PLC.

6. Set a way for PLC to send the message to slaves.
   **Note:**
   For broadcast mode, you need to set the slave address to 0 on the PLC side.
   For unicast mode, you need to set the desired target slave address on the PLC side.
   For example, if you want to send the message to slave 1, you need to set the slave address to 1 on the PLC side.

7. Write the control word via the PLC.
   **Note:**
   Bit 10 of the register 40100 must be set to 1 to allow the PLC to control the drive.
   You need to trigger a rise edge for OFF1 to enable SON status for the motor, and OFF2 and OFF3 must be set to 1. The step must be executed when you enable SON for the first time.

8. Write the setpoint and read the status word via PLC.

**Example**

This example shows the operating procedures when we use the setpoint and control word from Modbus (p29008 = 1) as the Modbus control source in S control mode.

1. Set RS485 bus address for the drive.
   - p29004 = 1
2. Select the Modbus protocol by p29007.
   - p29007 = 2
3. Select Modbus control source by p29008.
   - p29008 = 1
4. Set the transmission baud rate by p29009.
   - p29009 = 8 (38400 baud)
5. Set the drive work mode to S control mode.
6. Save the parameters and restart the drive.
7. Configure the PLC parameters.

Note:
Keep the PLC baud rate the same as the drive setting.
Set even parity check for the PLC (parity = 2).

8. Set a way for PLC sending message to slaves. Here we use the unicast mode and we only want to send the message to slave 1.

Note:
If you want to send the message to all slaves, you need to set the slave address to 0 to use the broadcast mode.
9. Write the control word you desired via the register 40100.

Note:
Bit 10 of the register 40100 must be set to 1 to allow the PLC to control the drive.
You need to trigger a rise edge for OFF1 to enable SON status for the motor, and OFF2 and OFF3 must be set to 1. The step must be executed when you enable SON for the first time.
For example, we write 0x41E to the register 40100 firstly and then write 0x41F to the register. The motor now is in SON status. You can check the control word definition table below to see the meaning of "0x41E" and "0x41F".

10. Write the speed setpoint via the register 40101.

Note:
You can calculate the actual speed value with the scale factor. Value 0x4000 represents the value of 100% × motor rated speed. Therefore, 0x2000 represents half of the motor rated speed.
### Process data overview

<table>
<thead>
<tr>
<th>Control mode</th>
<th>PTI</th>
<th>IPos</th>
<th>S</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control data</td>
<td>40100</td>
<td>PTI mode control word</td>
<td>IPos mode control word</td>
<td>S mode control word</td>
</tr>
<tr>
<td>40101</td>
<td>-</td>
<td>-</td>
<td>Speed setpoint</td>
<td>-</td>
</tr>
<tr>
<td>40102</td>
<td>-</td>
<td>-</td>
<td>Position setpoint high word</td>
<td>-</td>
</tr>
<tr>
<td>40103</td>
<td>-</td>
<td>-</td>
<td>Position setpoint low word</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status data</th>
<th>40110</th>
<th>Status word</th>
<th>Status word</th>
<th>Status word</th>
<th>Status word</th>
</tr>
</thead>
<tbody>
<tr>
<td>40111</td>
<td>Actual speed</td>
<td>Actual speed</td>
<td>Actual speed</td>
<td>Actual speed</td>
<td></td>
</tr>
<tr>
<td>40112</td>
<td>Actual position high word</td>
<td>Actual position high word</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40113</td>
<td>Actual position low word</td>
<td>Actual position low word</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Definition of the register 40100

<table>
<thead>
<tr>
<th>Bit</th>
<th>PTI control mode</th>
<th>IPos control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Signals</td>
<td>Description</td>
</tr>
<tr>
<td>0</td>
<td>SON_OFF1</td>
<td>Rising edge to enable SON (pulses can be enabled). 0: OFF1 (braking with ramp-function generator, then pulse cancellation, ready to power up)</td>
</tr>
<tr>
<td>1</td>
<td>OFF2</td>
<td>1: No OFF2 (enable is possible) 0: OFF2 (immediate pulse cancellation and power on inhibit)</td>
</tr>
<tr>
<td>2</td>
<td>OFF3</td>
<td>1: No OFF3 (enable is possible) 0: OFF3 (fast braking then pulse cancellation and power on inhibit)</td>
</tr>
<tr>
<td>3</td>
<td>OPER</td>
<td>1: Enable operation (pulses can be enabled) 0: Inhibit operation (cancel pulses)</td>
</tr>
<tr>
<td>4</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>RESET</td>
<td>Reset faults</td>
</tr>
<tr>
<td>8</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>9</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>10</td>
<td>PLC</td>
<td>Enable master control from the PLC</td>
</tr>
<tr>
<td>11</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>12</td>
<td>Reserved</td>
<td>-</td>
</tr>
</tbody>
</table>
### PTI control mode

<table>
<thead>
<tr>
<th>Bit</th>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>14</td>
<td>Reserved</td>
<td>Reserved</td>
</tr>
<tr>
<td>15</td>
<td>Reserved</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

### IPos control mode

<table>
<thead>
<tr>
<th>Bit</th>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SREF</td>
<td>Start referencing (act as REF for reference mode 0)</td>
</tr>
</tbody>
</table>

### S control mode

<table>
<thead>
<tr>
<th>Bit</th>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SON_OFF1</td>
<td>Rising edge to enable SON (pulses can be enabled), 0: OFF1 (braking with ramp-function generator, then pulse cancellation, ready to power up)</td>
</tr>
<tr>
<td>1</td>
<td>OFF2</td>
<td>1: No OFF2 (enable is possible), 0: OFF2 (immediate pulse cancellation and power on inhibit)</td>
</tr>
<tr>
<td>2</td>
<td>OFF3</td>
<td>1: no OFF3 (enable is possible), 0: OFF3 (fast braking then pulse cancellation and power on inhibit)</td>
</tr>
<tr>
<td>3</td>
<td>OPER</td>
<td>1: Enable operation (pulses can be enabled), 0: Inhibit operation (cancel pulses)</td>
</tr>
<tr>
<td>4</td>
<td>EN_RAMP</td>
<td>1: Operating condition (the ramp function generator can be enabled), 0: Inhibit ramp function generator (set the ramp function generator output to zero)</td>
</tr>
<tr>
<td>5</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>RESET</td>
<td>Reset faults</td>
</tr>
<tr>
<td>8</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>9</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>10</td>
<td>PLC</td>
<td>Enable master control from the PLC</td>
</tr>
<tr>
<td>11</td>
<td>Rev</td>
<td>Direction of rotation reversal</td>
</tr>
<tr>
<td>12</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>13</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>14</td>
<td>Reserved</td>
<td>-</td>
</tr>
<tr>
<td>15</td>
<td>Reserved</td>
<td>-</td>
</tr>
</tbody>
</table>
Note
The following signals are occupied by Modbus control word when you use the setpoint and control word from Modbus as the Modbus control source (p29008 = 1). They can only be enabled by Modbus control word while cannot be enabled by external DI terminals.
- PTI control mode: SON
- IPos control mode: SON, SREF (REF for reference mode 0)
- S control mode: SON, CWE/CCWE
- T control mode: SON

Note
In IPos control mode, when the relative positioning mode is selected, the method for accepting MDI setpoint must be a rising edge (bit 5 = 0); otherwise, fault F7488 occurs.

Note
In IPos control mode, when you implement the absolute positioning for the modular axis with Modbus, you can select the MDI direction with parameter p29230.

Note
In T control mode, the motor cannot be stopped with OFF1 via Modbus.

Note
All the reserved bits in register 40100 must be set to 0.

Definition of register 40110

<table>
<thead>
<tr>
<th>Bit</th>
<th>PTI, IPos, S and T control modes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Signals</td>
</tr>
<tr>
<td>0</td>
<td>RDY</td>
</tr>
<tr>
<td>1</td>
<td>FAULT</td>
</tr>
<tr>
<td>2</td>
<td>INP</td>
</tr>
<tr>
<td>3</td>
<td>ZSP</td>
</tr>
<tr>
<td>4</td>
<td>SPDR</td>
</tr>
<tr>
<td>5</td>
<td>TLR</td>
</tr>
<tr>
<td>6</td>
<td>SPLR</td>
</tr>
<tr>
<td>7</td>
<td>MBR</td>
</tr>
<tr>
<td>8</td>
<td>OLL</td>
</tr>
<tr>
<td>9</td>
<td>WARNING 1</td>
</tr>
<tr>
<td>10</td>
<td>WARNING 2</td>
</tr>
<tr>
<td>11</td>
<td>REFOK</td>
</tr>
<tr>
<td>12</td>
<td>MODE 2</td>
</tr>
<tr>
<td>13</td>
<td>Reserved</td>
</tr>
<tr>
<td>14</td>
<td>Reserved</td>
</tr>
<tr>
<td>15</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
DI simulation

The digital input signals can be simulated by Modbus with registers 40281 and 40283.

<table>
<thead>
<tr>
<th>Digital input</th>
<th>DI1</th>
<th>DI2</th>
<th>DI3</th>
<th>DI4</th>
<th>DI5</th>
<th>DI6</th>
<th>DI7</th>
<th>DI8</th>
<th>DI9</th>
<th>DI10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register 40281 (p0795)</td>
<td>Bit 0</td>
<td>Bit 1</td>
<td>Bit 2</td>
<td>Bit 3</td>
<td>Bit 4</td>
<td>Bit 5</td>
<td>Bit 6</td>
<td>Bit 7</td>
<td>Bit 8</td>
<td>Bit 9</td>
</tr>
<tr>
<td>Register 40283 (p0796)</td>
<td>Bit 0</td>
<td>Bit 1</td>
<td>Bit 2</td>
<td>Bit 3</td>
<td>Bit 4</td>
<td>Bit 5</td>
<td>Bit 6</td>
<td>Bit 7</td>
<td>Bit 8</td>
<td>Bit 9</td>
</tr>
</tbody>
</table>

- Set the simulation mode for DIs with register 40281
  Bit 0 to bit 9 of register 40281 can be used to set the simulation mode for DI1 to DI 10. For example, if you want to simulate DI1 with Modbus, you need to set bit 0 = 1 for register 40281.

- Set the setpoint for DIs with register 40283
  Bit 0 to bit 9 of register 40283 can be used to set the setpoint for the simulated DI signals. After the DI simulation mode is set, you can set the setpoint for a DI signal with register 40283 to enable the DI signal. For example, if you have set bit 0 = 1 for register 40281, to enable signal DI1, you need to set the trigger condition (rising edge or high level) for bit 0 of register 40283.

**DI simulation example in S control mode**

In S control mode, the default digital input signal assignment is as follows:

<table>
<thead>
<tr>
<th>Digital input</th>
<th>DI1</th>
<th>DI2</th>
<th>DI3</th>
<th>DI4</th>
<th>DI5</th>
<th>DI6</th>
<th>DI7</th>
<th>DI8</th>
<th>DI9</th>
<th>DI10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>SON</td>
<td>REST</td>
<td>CWL</td>
<td>CCWL</td>
<td>CWE</td>
<td>CCWE</td>
<td>SPD1</td>
<td>SPD2</td>
<td>EMGS</td>
<td>C-MODE</td>
</tr>
<tr>
<td>Register 40281 (p0795)</td>
<td>Bit 0</td>
<td>Bit 1</td>
<td>Bit 2</td>
<td>Bit 3</td>
<td>Bit 4</td>
<td>Bit 5</td>
<td>Bit 6</td>
<td>Bit 7</td>
<td>Bit 8</td>
<td>Bit 9</td>
</tr>
<tr>
<td>Register 40283 (p0796)</td>
<td>Bit 0</td>
<td>Bit 1</td>
<td>Bit 2</td>
<td>Bit 3</td>
<td>Bit 4</td>
<td>Bit 5</td>
<td>Bit 6</td>
<td>Bit 7</td>
<td>Bit 8</td>
<td>Bit 9</td>
</tr>
</tbody>
</table>

For more information about the DI assignment, see Section "Digital inputs/outputs (DIs/Dos) (Page 94)".

- Set the simulation mode for DI1
  To simulate DI1 with Modbus, you need to set bit 0 = 1 for register 40281.

- Set the setpoint for DI1
  After the simulation mode of DI1 is set, you can set the setpoint for DI1 with register 40283 to enable the DI signal.

  In S control mode, DI1 is assigned with SON by default, so we need to trigger a rising edge to enable the SON signal. Set bit 0 = 0 for register 40283 and then set the bit to 1. A rising edge is triggered. The motor is now in "S ON" state.
4.6.2.2  Acyclic communication

The SINAMICS V90 servo drive supports acyclic communication via data set 47.

The maximum data length per request is 240 bytes.

Note
Values in italics

Values in italics in the following tables mean that you have to adjust these values for a specific request.

Data block setting

Reading parameter values

The table below formats a request to read parameters.

<table>
<thead>
<tr>
<th>Data block</th>
<th>Byte n</th>
<th>Bytes n + 1</th>
<th>n</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Reference</td>
<td>00 hex ... FF hex</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>02 hex (ID of drive objects, at V90 always = 2)</td>
<td>01 hex: Read job</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Number of parameters (m)</td>
<td>02 hex: Read job</td>
<td>2</td>
</tr>
<tr>
<td>Address, parameter 1</td>
<td>Attribute</td>
<td>10 hex: Parameter value</td>
<td>Number of the indices</td>
</tr>
<tr>
<td></td>
<td>Parameter number</td>
<td>0001 hex ... FFFF hex</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Number of the 1st index</td>
<td>0000 hex ... FFFF hex</td>
<td>(for parameters without index: 0000 hex)</td>
</tr>
<tr>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>Address, parameter m</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

The table below formats the drive response to a read request.

<table>
<thead>
<tr>
<th>Data block</th>
<th>Byte n</th>
<th>Bytes n + 1</th>
<th>n</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Reference (identical to a read request)</td>
<td>01 hex: Drive has executed the read request. 81 hex: Drive was not able to completely execute the read request.</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>02 hex (ID of drive objects, at V90 always = 2)</td>
<td>Number of parameters (m) (identical to the read request)</td>
<td>2</td>
</tr>
</tbody>
</table>
### Changing parameter values

The table below formats a request to change parameters.

<table>
<thead>
<tr>
<th>Data block</th>
<th>Byte n</th>
<th>Bytes n + 1</th>
<th>n</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Header</strong></td>
<td><strong>Reference</strong></td>
<td>00 hex ... FF hex</td>
<td>02 hex: Change request</td>
</tr>
<tr>
<td></td>
<td><strong>ID of drive objects, at V90 always = 2</strong></td>
<td>02 hex</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td><strong>Number of parameters (m)</strong></td>
<td>01 hex ... 27 hex</td>
<td>2</td>
</tr>
<tr>
<td><strong>Address, parameter 1</strong></td>
<td><strong>10 hex: Parameter value</strong></td>
<td><strong>Number of indices</strong></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td><strong>00 hex ... EA hex</strong></td>
<td><strong>(00 hex and 01 hex are equivalents)</strong></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td><strong>Parameter number</strong></td>
<td><strong>0001 hex ... FFFF hex</strong></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td><strong>Number of the 1st Index</strong></td>
<td><strong>0001 hex ... FFFF hex</strong></td>
<td>8</td>
</tr>
</tbody>
</table>
| | | ... | ...
| | **Address, parameter 2** | ... | ...
| | ... | ... | ...
| **Address, parameter m** | ... | ... | ...
### Data block

<table>
<thead>
<tr>
<th>Byte n</th>
<th>Bytes n + 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Values, parameter 1</td>
<td>Format</td>
</tr>
<tr>
<td></td>
<td>02 hex: Integer 8</td>
</tr>
<tr>
<td></td>
<td>03 hex: Integer 16</td>
</tr>
<tr>
<td></td>
<td>04 hex: Integer 32</td>
</tr>
<tr>
<td></td>
<td>05 hex: Unsigned 8</td>
</tr>
<tr>
<td></td>
<td>06 hex: Unsigned 16</td>
</tr>
<tr>
<td></td>
<td>07 hex: Unsigned 32</td>
</tr>
<tr>
<td></td>
<td>08 hex: Floating Point</td>
</tr>
<tr>
<td></td>
<td>0A hex: Octet String</td>
</tr>
<tr>
<td></td>
<td>0D hex: Time Difference</td>
</tr>
<tr>
<td></td>
<td>34 hex: TimeOfDay without date indication</td>
</tr>
<tr>
<td></td>
<td>35 hex: TimeDifference with date indication</td>
</tr>
<tr>
<td></td>
<td>36 hex: TimeDifference without date indication</td>
</tr>
<tr>
<td></td>
<td>41 hex: Byte</td>
</tr>
<tr>
<td></td>
<td>42 hex: Word</td>
</tr>
<tr>
<td></td>
<td>43 hex: Double word</td>
</tr>
<tr>
<td>Number of index values</td>
<td>00 hex ... EA hex</td>
</tr>
<tr>
<td>Value of the 1st index</td>
<td>...</td>
</tr>
<tr>
<td>Values, parameter 2</td>
<td>...</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>Values, parameter m</td>
<td>...</td>
</tr>
</tbody>
</table>

The table below formats the response when the drive has executed the change request.

<table>
<thead>
<tr>
<th>Data block</th>
<th>Byte n</th>
<th>Bytes n + 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Reference (identical to a change request)</td>
<td>02 hex (change request successful) 0</td>
</tr>
<tr>
<td></td>
<td>02 hex (ID of drive objects, at V90 always = 2)</td>
<td>Number of parameters (identical to a change request) 2</td>
</tr>
</tbody>
</table>

The table below formats the response when the drive was not able to completely execute the change request.

<table>
<thead>
<tr>
<th>Data block</th>
<th>Byte n</th>
<th>Bytes n + 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Reference (identical to a change request)</td>
<td>82 hex: (Drive was not able to completely execute the write request) 0</td>
</tr>
<tr>
<td></td>
<td>02 hex (ID of drive objects, at V90 always = 2)</td>
<td>Number of parameters (identical to a change request) 2</td>
</tr>
<tr>
<td>Values, parameter 1</td>
<td>Format</td>
<td></td>
</tr>
<tr>
<td></td>
<td>40 hex: Zero (change request for this data block executed)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>44 hex: Error (change request for this data block not executed)</td>
<td></td>
</tr>
<tr>
<td>Number of error values</td>
<td>00 hex</td>
<td></td>
</tr>
<tr>
<td>01 hex or 02 hex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Only for &quot;Error&quot; - error value 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You can find the error values in the table at the end of this section. 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Only for &quot;Error&quot; - error value 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error value 2 is either zero, or it contains the number of the first index where the error occurred. 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Values, parameter 2</td>
<td>...</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Values, parameter m</td>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>
### Error values

See the table below for error values in the parameter response.

<table>
<thead>
<tr>
<th>Error value 1</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>00 hex</td>
<td>Illegal parameter number (access to a parameter that does not exist)</td>
</tr>
<tr>
<td>01 hex</td>
<td>Parameter value cannot be changed (change request for a parameter value that cannot be changed)</td>
</tr>
<tr>
<td>02 hex</td>
<td>Lower or upper value limit exceeded (change request with a value outside the value limits)</td>
</tr>
<tr>
<td>03 hex</td>
<td>Incorrect subindex (access to a parameter index that does not exist)</td>
</tr>
<tr>
<td>04 hex</td>
<td>No array (access with a subindex to non-indexed parameters)</td>
</tr>
<tr>
<td>05 hex</td>
<td>Incorrect data type (change request with a value that does not match the data type of the parameter)</td>
</tr>
<tr>
<td>06 hex</td>
<td>Setting not permitted, only resetting (change request with a value not equal to 0 without permission)</td>
</tr>
<tr>
<td>07 hex</td>
<td>Descriptive element cannot be changed (change request to a descriptive element that cannot be changed)</td>
</tr>
<tr>
<td>09 hex</td>
<td>Description data not available (access to a description that does not exist, parameter value is available)</td>
</tr>
<tr>
<td>0B hex</td>
<td>No master control (change request but with no master control)</td>
</tr>
<tr>
<td>0F hex</td>
<td>Text array does not exist (although the parameter value is available, the request is made to a text array that does not exist)</td>
</tr>
<tr>
<td>11 hex</td>
<td>Request cannot be executed due to the operating state (access is not possible for temporary reasons that are not specified)</td>
</tr>
<tr>
<td>14 hex</td>
<td>Inadmissible value (change request with a value that is within the limits but which is illegal for other permanent reasons, i.e. a parameter with defined individual values)</td>
</tr>
<tr>
<td>15 hex</td>
<td>Response too long (the length of the actual response exceeds the maximum transfer length)</td>
</tr>
<tr>
<td>16 hex</td>
<td>Illegal parameter address (illegal or unsupported value for attribute, number of elements, parameter number, subindex or a combination of these)</td>
</tr>
<tr>
<td>17 hex</td>
<td>Illegal format (change request for an illegal or unsupported format)</td>
</tr>
<tr>
<td>18 hex</td>
<td>Number of values not consistent (number of values of the parameter data to not match the number of elements in the parameter address)</td>
</tr>
<tr>
<td>19 hex</td>
<td>Drive object does not exist (access to a drive object that does not exist)</td>
</tr>
<tr>
<td>20 hex</td>
<td>Parameter text cannot be changed</td>
</tr>
<tr>
<td>21 hex</td>
<td>Service is not supported (illegal or not support request ID).</td>
</tr>
<tr>
<td>6B hex</td>
<td>A change request for a controller that has been enabled is not possible. (The drive rejects the change request because the motor is switched on. Please observe the &quot;Can be changed&quot; parameter attribute (U, T) as given in the parameter list relevant section in the SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions.</td>
</tr>
<tr>
<td>6C hex</td>
<td>Unknown unit.</td>
</tr>
<tr>
<td>77 hex</td>
<td>Change request is not possible during download.</td>
</tr>
<tr>
<td>81 hex</td>
<td>Change request is not possible during download.</td>
</tr>
<tr>
<td>82 hex</td>
<td>Accepting the master control is inhibited.</td>
</tr>
<tr>
<td>83 hex</td>
<td>Desired interconnection is not possible (the connector output does not supply a float value although the connector input requires a float value)</td>
</tr>
<tr>
<td>84 hex</td>
<td>Inverter does not accept a change request (inverter is busy with internal calculations.</td>
</tr>
<tr>
<td>85 hex</td>
<td>No access methods defined.</td>
</tr>
<tr>
<td>87 hex</td>
<td>Know-how protection active, access locked</td>
</tr>
<tr>
<td>C8 hex</td>
<td>Change request below the currently valid limit (change request to a value that lies within the &quot;absolute&quot; limits, but is however below the currently valid lower limit)</td>
</tr>
</tbody>
</table>
### Error values 1

<table>
<thead>
<tr>
<th>Error value 1</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>C9 hex</td>
<td>Change request above the currently valid limit (example: a parameter value is too large for the drive power)</td>
</tr>
<tr>
<td>CC hex</td>
<td>Change request not permitted (change is not permitted as the access code is not available)</td>
</tr>
</tbody>
</table>

### Examples

Via FC 16, with one request, up to 122 registers can be written to directly one after the other.

#### Header

In addition to the slave address, enter the transfer type, the start address and the number of the following registers in the header.

#### User data

You control the access in the user data via register 40601.

In register 40602, you define the acyclic access as well as the length of the request data.

Register 40603 contains the request reference, which is defined by the user, and the access type reading or writing.

From register 40603 and higher, the request aligns acyclic communication via data set 47.

Register 40604 contains the number of the drive object (for V90 always 2) and the number of parameters that are read out or written to.

Register 40605 contains the attribute (for V90 always 0x10). In the number of elements you specify how many indices are read.

#### Example: p1215 and p1120 read acyclically

The table below formats a request to read the parameter values of p1215 and p1120 from slave number 1.

<table>
<thead>
<tr>
<th>Header</th>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 h</td>
<td>0</td>
<td>Slave address</td>
</tr>
<tr>
<td>10 h</td>
<td>1</td>
<td>Function code (write multiple)</td>
</tr>
<tr>
<td>0258 h</td>
<td>2,3</td>
<td>Register start address</td>
</tr>
<tr>
<td>000A h</td>
<td>4,5</td>
<td>Number of registers to be read (40601 ... 40610)</td>
</tr>
<tr>
<td>14 h</td>
<td>6</td>
<td>Number of data bytes (10 registers, each 2 bytes = 20 bytes)</td>
</tr>
</tbody>
</table>
## Byte Description

### User data

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001 h</td>
<td>7,8</td>
</tr>
<tr>
<td>2F10 h</td>
<td>9,10</td>
</tr>
<tr>
<td>8001 h</td>
<td>11,12</td>
</tr>
<tr>
<td>0202 h</td>
<td>13,14</td>
</tr>
<tr>
<td>1001 h</td>
<td>15,16</td>
</tr>
<tr>
<td>04BF h</td>
<td>17,18</td>
</tr>
<tr>
<td>0000 h</td>
<td>19,20</td>
</tr>
<tr>
<td>0460 h</td>
<td>21,22</td>
</tr>
<tr>
<td>0000 h</td>
<td>23,24</td>
</tr>
<tr>
<td>04610: Second parameter subindex = 0</td>
<td></td>
</tr>
</tbody>
</table>

### Status Chart

<table>
<thead>
<tr>
<th>Address</th>
<th>Format</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hexadecimal</td>
<td>1640001</td>
</tr>
<tr>
<td>2</td>
<td>Hexadecimal</td>
<td>1640002</td>
</tr>
<tr>
<td>3</td>
<td>Hexadecimal</td>
<td>1640003</td>
</tr>
<tr>
<td>4</td>
<td>Hexadecimal</td>
<td>1640004</td>
</tr>
<tr>
<td>5</td>
<td>Hexadecimal</td>
<td>1640005</td>
</tr>
<tr>
<td>6</td>
<td>Signed</td>
<td>-1275</td>
</tr>
<tr>
<td>7</td>
<td>Hexadecimal</td>
<td>1640006</td>
</tr>
<tr>
<td>8</td>
<td>Hexadecimal</td>
<td>1640007</td>
</tr>
<tr>
<td>9</td>
<td>Unsigned</td>
<td>1120</td>
</tr>
<tr>
<td>10</td>
<td>Hexadecimal</td>
<td>1640008</td>
</tr>
</tbody>
</table>

## Write the PLC command from registers 40601 to 40610:

### The table below formats a response for successful read operation.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Slave address</td>
</tr>
<tr>
<td>01 h</td>
<td>0</td>
</tr>
<tr>
<td>03 h</td>
<td>1</td>
</tr>
<tr>
<td>20 h</td>
<td>2</td>
</tr>
<tr>
<td>User data</td>
<td>40601: DS47 Control = 2 (the request was executed)</td>
</tr>
<tr>
<td>0002 h</td>
<td>3,4</td>
</tr>
<tr>
<td>2F0E h</td>
<td>5,6</td>
</tr>
<tr>
<td>8001 h</td>
<td>7,8</td>
</tr>
<tr>
<td>0202 h</td>
<td>9,10</td>
</tr>
<tr>
<td>0001 h</td>
<td>11,12</td>
</tr>
<tr>
<td>0801 h</td>
<td>13,14</td>
</tr>
<tr>
<td>4142 h</td>
<td>15,16</td>
</tr>
<tr>
<td>6666 h</td>
<td>19,20</td>
</tr>
</tbody>
</table>
Write the PLC command from registers 40601 to 40609:

The table below formats a response for unsuccessful read operation (read request still not completed).

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 h</td>
<td>Slave address</td>
</tr>
<tr>
<td>03 h</td>
<td>Function code (read)</td>
</tr>
<tr>
<td>20 h</td>
<td>Number of following data bytes (20 h: 32 bytes ≙ 16 registers)</td>
</tr>
</tbody>
</table>

User data:

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001 h</td>
<td>3,4 40601: Check value 1 = request is processed</td>
</tr>
<tr>
<td>2F00 h</td>
<td>5,6 40602: Function 2F h(47), response length 0 (fault)</td>
</tr>
<tr>
<td>0004 h</td>
<td>7,8 40603: Error code: 0004 Response Not Ready (response has still not been issued)</td>
</tr>
</tbody>
</table>

Example: Set p1121 = 11.28 and p29130 = 2

The table below formats a request to write the parameter values of p1121 and p29130 from slave number 1.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 h</td>
<td>Slave address</td>
</tr>
<tr>
<td>10 h</td>
<td>Function code (write multiple)</td>
</tr>
<tr>
<td>0258 h</td>
<td>Register start address</td>
</tr>
<tr>
<td>000A h</td>
<td>4,5 Number of registers to be written to (40601 ... 40615)</td>
</tr>
<tr>
<td>1E h</td>
<td>Number of data bytes (15 registers, each 2 bytes = 30 bytes)</td>
</tr>
</tbody>
</table>
Byte | Description
--- | ---
0001 h | 7,8: 40601: ds47 = 1 (activate request)
2F1A h | 9,10: 40602: Function 2F h (47), request length 16 bytes (10 h)
8002 h | 11,12: 40603: Request reference = 80 h, request identifier = 2 h (write)
0202 h | 13,14: 40604: V90 = 2 h, number of parameters = 2
1001 h | 15,16: 40605: Attribute, number of elements of the first parameter
0461 h | 17,18: 40606: First parameter number = p1121
0000 h | 19,20: 40607: First parameter subindex = 0
1001 h | 21,22: 40608: Attribute, number of elements of the second parameter
71CA h | 23,24: 40609: Second parameter number = p29130
0000 h | 25,26: 40610: Second parameter subindex = 0
0801 h | 27,28: 40611: Format, number of values of the first parameter
4134 h | 29,30: 40612: First parameter value 11.28 (41347AE1 h)
7AE1 h | 31,32: 40613: First parameter value
33,34: 40614: Format, number of values of the second parameter
0002 h | 35,36: 40615: Second parameter value 2

Write the PLC command from registers 40601 to 40615:

The table below formats a response for successful write operation.

<table>
<thead>
<tr>
<th>Address</th>
<th>Format</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hexadecimal</td>
<td>1590001</td>
</tr>
<tr>
<td>2</td>
<td>Hexadecimal</td>
<td>1590002</td>
</tr>
<tr>
<td>3</td>
<td>Hexadecimal</td>
<td>1590003</td>
</tr>
<tr>
<td>4</td>
<td>Hexadecimal</td>
<td>1590004</td>
</tr>
<tr>
<td>5</td>
<td>Hexadecimal</td>
<td>1590005</td>
</tr>
<tr>
<td>6</td>
<td>Hexadecimal</td>
<td>1590006</td>
</tr>
<tr>
<td>7</td>
<td>Hexadecimal</td>
<td>1590007</td>
</tr>
<tr>
<td>8</td>
<td>Hexadecimal</td>
<td>1590008</td>
</tr>
<tr>
<td>9</td>
<td>Hexadecimal</td>
<td>1590009</td>
</tr>
<tr>
<td>10</td>
<td>Hexadecimal</td>
<td>1590010</td>
</tr>
<tr>
<td>11</td>
<td>Hexadecimal</td>
<td>1590011</td>
</tr>
<tr>
<td>12</td>
<td>Hexadecimal</td>
<td>1590012</td>
</tr>
<tr>
<td>13</td>
<td>Hexadecimal</td>
<td>1590013</td>
</tr>
<tr>
<td>14</td>
<td>Hexadecimal</td>
<td>1590014</td>
</tr>
<tr>
<td>15</td>
<td>Hexadecimal</td>
<td>1590015</td>
</tr>
</tbody>
</table>

Table 4-1 Response for successful write operation

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 h</td>
<td>0: Slave address</td>
</tr>
<tr>
<td>03 h</td>
<td>1: Function code (read)</td>
</tr>
<tr>
<td>20 h</td>
<td>2: Number of following data bytes (20 h: 32 bytes = 16 registers)</td>
</tr>
</tbody>
</table>

User data

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0002 h</td>
<td>3,4: 40601: DS47 Control = 2 (request was executed)</td>
</tr>
<tr>
<td>2F04 h</td>
<td>5,6: 40602: Function code 2F h (47), response length 4 bytes</td>
</tr>
<tr>
<td>8002 h</td>
<td>7,8: 40603: Request reference mirrored = 80 h, response identifier = 2 (change parameter)</td>
</tr>
<tr>
<td>0202 h</td>
<td>9,10: 40604: V90 = 2 h, number of parameters = 2</td>
</tr>
</tbody>
</table>
Write the PLC command from registers 40601 to 40604:

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 h</td>
<td>Slave address</td>
</tr>
<tr>
<td>03 h</td>
<td>Function code (read)</td>
</tr>
<tr>
<td>20 h</td>
<td>Number of following data bytes (20 h: 32 bytes ≡ 16 registers)</td>
</tr>
</tbody>
</table>

User data:

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001 h</td>
<td>DS47 Control = 1 (request is processed)</td>
</tr>
<tr>
<td>2F00 h</td>
<td>Function 2F h(47), response length 0 (fault)</td>
</tr>
<tr>
<td>0004 h</td>
<td>Error code: 0004 Response Not Ready (response has still not been issued)</td>
</tr>
</tbody>
</table>

The table below formats a response for unsuccessful write operation (write request still not completed).
Index

Pulse train encoder outputs, 107
Pulse train inputs, 107

S
Select drive
  Control mode, 45
  Drive selection, 42
  Jog, 47
  Motor selection, 44
Set limits, 71
Set parameter setpoint, 56
Set PROFINET
  Configure network, 51
  Select telegram, 48
Speed limit, 73
Switch
  Go offline, 31
  Go online, 31

T
Test motor, 107
Toolbar, 36
Tools
  Factory default, 33
  Reset absolute encoder, 33
  Restart drive, 32
  Save parameters to ROM, 32
  Upload parameters, 35
Torque control mode
  Torque setpoint, 69
  Torque limit, 71
Trace configuration, 126

U
User interface, 25

W
Working modes, 19